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CommandCenter Topic Library

The CommandCenter Topic Library provides several options for finding information and taking it with you. Toolbar buttons      provide access
to these options. The toolbar is located in the upper right corner of the Topic Library.

The CommandCenter Topic Library is qualified with the Internet Explorer  browser and with the Chrome™ browser.

 Print CommandCenter topics:
1. In the left panel view, identify the single topic or group of topics to print. A group of topics to print must be a parent topic and its sub-topics.

2. Select the single topic or parent topic so it is displayed in your browser.

3. In the Topic Library toolbar, click one of the following:

Print topic 

Print topic and sub-topics 

4. Select your printer options.

Note: If your printer options support creating a pdf file, you can create a pdf file rather than printing.

Consider your bandwidth and system resources if you select a large number of topics. It can take several minutes to create a large pdf file.

5. Print or create a pdf file of the topic or topics.

 Download the CommandCenter Topic Library as:
PDF: Supported on all operating systems with a PDF reader application, such as the free Adobe Reader  application.

HTML: Supported on Windows  operating systems only. This single file contains the entire Topic Library.

 Navigate the online CommandCenter Topic Library:
Browse the left panel view of topics.

In the toolbar located in the upper right corner of the Topic Library, click Previous topic  and Next topic  to navigate sequentially.

In the toolbar, click Hide Navigation  to close the left panel and allow a wider reading area for your topic. Click again to open the left panel.

Use the links at the bottom of a topic to view related topics:
Related Topics link to topics related by subject.

Parent Topic and child topics, such as those below, link to topics related by topic hierarchy.
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CommandCenter Broadcast System Control

CommandCenter is a software application for the control, configuration, monitoring and maintenance of Grass Valley products. CommandCenter features include:

Network device configuration using a graphical user interface

Comprehensive status, alarm and audit logging

User configurable access to data and status

The ability to deploy as multiple user client/server or as a standalone application. The standalone CommandCenter is referred to as "Express" and the
client/server configuration is referred to as a "System." Additional options are available for both types of installation.

How to print CommandCenter Topic Library topics

How to download the CommandCenter Topic Library

How to navigate the CommandCenter Topic Library
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Software Requirements

Software requirements for running CommandCenter.

The following list outlines the software requirements for running CommandCenter.

CommandCenter runs on a Windows PC or Server hardware

Support for Windows XP, Vista, 7, 8

Support for Windows Server 2003/2008/2012

Uses MS SQL database for backend data storage:
The standard version is distributed with MS SQL Express (10GB storage limit)

Advanced features and redundancy require an upgrade to the full version of MS SQL

Systems are licensed through Sabretooth licensing
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Express Options

The following options are available for purchase. Once purchased, you will receive an XML file that contains the licensing keys. Use the License Manager to install
the keys. For more information on licensing, see the Licensing topic.

CMDCTR-EXP CommandCenter Express Standalone Application

CMDCTR-EXP-SNMP CommandCenter Express SNMP Software Option

CMDCTR-EXP-TALLY CommandCenter Express Multi-Level Tally Software Option

CMDCTR-EXP-GENERIC CommandCenter Express Generic Device Interface Software Option
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System Options

The following options are available for purchase. Once purchased, you will receive an XML file that contains the licensing keys. Use the License Manager to install
the keys. For more information on licensing, see the Licensing topic.

CMDCTR-SYSCommandCenter Multi-User Client-Server System Application for 2 User/Clients

CMDCTR-SYS-REDCommandCenter Redundant Server Software License

CMDCTR-SYS-SNMPCommandCenter Advanced SNMP Software Option

CMDCTR-SYS-TALLYCommandCenter Advanced Multi-Level Tally Software Option

CMDCTR-SYS-GENERIC CommandCenter Generic Device Interface Software Option

CMDCTR-SYS-CLIENTAdditional Client License

CMDCTR-SYS-CLIENT-ULCommandCenter Additional Maximum Client Licenses

CMDCTR-SERVERCommandCenter Server Hardware

CMDCTR-SERVER-RED CommandCenter Redundant Server Hardware
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Licensing

Systems are licensed through Sabretooth licensing.

1.  Install the SabreTooth License Generator by double-clicking on the icon called "License Manager" located on your desktop.
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2.  From the File menu, select ‘Generate Unique ID.’ 

3.  Click Copy to Clipboard to copy the Unique ID. 

4. Email the Unique ID to Grass Valley.

5. When you receive the license from Grass Valley, open the SabreTooth License Manager.

6. Select File, "Import License" to import the returned license. 
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CommandCenter - Standalone Application

The standalone application is suitable for 1-4 CommandCenter workstations.

This scenario shows a typical small system with CommandCenter Servers being added to an existing facility. The CommandCetner can operate without the need
for any reconfiguring of the current facility and provides additional control and monitoring capabilities. Up to 4 CommandCenter Servers to provide distribution of
control functions if desired. This does not offer direct redundancy. 
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Multiple Client Server Topology

The CommandCenter Server application can support multiple clients. The CommandCenter Client installation does not require SQL. The CMDCTR-SYS-SNMP
option enables the SNMP features in all clients.The CMDCTR-SERVER-RED redundant server option uses a licensed version of SQL Server for SQL mirroring.
The CommandCenter Client or CommandCenter witness application acts as an independent watchdog for the CommandCenter server and SQL, with manual or
automatic changeover. CCLink protocol is used between server and clients. (Multicast network packets are used for status updates to reduce duplication of
network packets.)
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CommandCenter - Multiple Clients/Single Server

A Client Server arrangement provides for multiple Clients to Control or Monitor a facility simultaneously.

All system information and configuration is stored on an SQL database on the Server. Clients download information from the Server as needed. Router Control
panels can talk directly with the Server and are programmed through the CommandCenter software. This provides both custom soft panels and hard panels to
share information. Client licenses are floating. First clients will get access to the licenses.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.



4/2/2014 CommandCenter Topic Library

http://127.0.0.1:4587/core/sub/topic/t_topichead_topic_library_options.html 5/111

CommandCenter - Multiple Clients/Redundant Servers

A client Server system can also be set up as a Redundant system with 2 Servers acting as primary and backup.

A client server system can also be set up as a redundant system with 2 servers acting as primary and backup. The SQL database is mirrored between the 2
Servers with a third PC acting as a witness to monitor server operation and prevent indecisions over which server is in control. This does not provide redundancy
for configuration data at this time. Failover time is around 5-10 seconds.
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Adding CommandCenter to a Jupiter Router

This is an overview of adding CommandCenter to an existing router.

The Jupiter controller must be a CM 4000 or CM4400. The Command Center Client and CommandCenter Panels communicate with the CommandCenter Server
which in turn controls the Router through the CM4400. Existing Jupiter Panels can remain on the Jupiter controller or be moved to the CommandCenter Server.
This decision is based on the features required to control the Router.
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Configuring a Jupiter Router for CommandCenter

The Jupiter Configuration must be performed first to establish the Router parameters.

Matrix – Configure the size and number of controllable Levels

Inputs – Define and name the Sources

Outputs – Define and Name the Destinations

Levels – Define and Name the Levels

External Automation interface – This must be done within the Jupiter CM4400 Controller

Existing Panels – These can communicate to the Router or Command Center

Note: You must use the Jupiter system must be used for the Salvos and Exclusion features as they are not available within Command Center in this software.
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CommandCenter Hardware

The following selection of hardware panels are availabe to work with CommandCenter.

These panels come from the Jupiter or Encore control systems. The panels can have a simple configuration or be fully customized. The general purpose interface
unit provides inputs and outputs for tally.

Jupiter Panels

LCD16, LCD48

LD4, LD16, L64 , L32

S100, S50, S25, SXY

Encore Panels

48B, BPS, CLNT

PMB, UCP, XY

General Purpose Interface Unit

CGP-4848 1RU 48 input/output GPI unit
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Panel Firmware Installation Instructions

PanelFirmware.zip needs to be extracted to the same directory where the NetConfig is currently installed, but not directly into the NetConfig folder.

1.  Unzip the PanelFirmware.zip file.

2.  Extract the PanelFirmware.zip file into the directory where NetConfig was installed, but not directly into the NetConfig folder.
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CommandCenter Installation

Before you install CommandCenter, be sure your PC meets the minimum system requirements:

Windows .Net 3.51 SP1 or later,

Win Installer 4.5 or later, IE 6.0 SP1 or later, Adobe Reader V8

Windows XP, Vista, 7, 8, RT Windows Server 2003, 2008, 2012

Recommended Resolution 1280x1024 (1024x768 acceptable)

1GB RAM min, 4GB or greater recommended

Hard Drive Space 5GB (160 GB recommended – for Database)

Refer to the "System Requirements" topic for more complete information.

There is a single CommandCenter installer for all applications: an icon labled ‘setup’

Double-click on the setup icon to install the following applications:

CommandCenter (Standalone or Server) either x86 or x64

CommandCenter Client

CommandCenter Form Designer

There is no need to un-install any previous versions of CommandCenter, unless the software is being reinstalled

Client application and Server can be different versions, although the new functionality might not be available.

Applications are normally installed to:

C:\Program\Grass Valley \CommandCenter
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Sub-directories contain all the required files for the program.
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CommandCenter Installation

Before you install CommandCenter, be sure your PC meets the minimum system requirements:

Windows .Net 3.51 SP1 or later,

Win Installer 4.5 or later, IE 6.0 SP1 or later, Adobe Reader V8

Windows XP, Vista, 7, 8, RT Windows Server 2003, 2008, 2012

Recommended Resolution 1280x1024 (1024x768 acceptable)

1GB RAM min, 4GB or greater recommended

Hard Drive Space 5GB (160 GB recommended – for Database)

Refer to the "System Requirements" topic for more complete information.

There is a single CommandCenter installer for all applications: an icon labled ‘setup’

Double-click on the setup icon to install the following applications:

CommandCenter (Standalone or Server) either x86 or x64

CommandCenter Client

CommandCenter Form Designer

There is no need to un-install any previous versions of CommandCenter, unless the software is being reinstalled

Client application and Server can be different versions, although the new functionality might not be available.

Applications are normally installed to:

C:\Program\Grass Valley \CommandCenter



4/2/2014 CommandCenter Topic Library

http://127.0.0.1:4587/core/sub/topic/t_topichead_topic_library_options.html 9/111

Sub-directories contain all the required files for the program.
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System Requirements

The following table lists the prerequisite software and minimum hardware and software requirements for running CommandCenter. To determine if the computer
meets the system requirements, from the Start menu, right-click My Computer, and then click Properties. The General tab displays the CPU type and speed,

and the amount of installed memory (RAM).

Table 1. CommandCenter System Requirements

Prerequisite software Microsoft .NET Framework 3.5 SP1 or later

Microsoft Windows Installer 4.5 or later

Microsoft Internet Explorer 6.0 Service Pack 1 (SP1) or later (prerequisite for
.NET Framework)

Adobe Acrobat Reader V8 or later for manual viewer

RAM Minimum: 1GB

Recommended: 4GB or more

Hard Disk space Minimum: 5GB

Recommended: 160GB or higher

Processor Type:Pentium III-compatible processor or faster

Speed: Minimum: 1GHz, Recommended: 2GHz or faster

Operating System The Cortex application supports all versions of Windows operating systems
later than XP excluding Windows XP Embedded Edition.

Cortex also relies on a version of Microsoft SQL Server running on the PC.

Cortex is currently distributed with SQL Server 2008 R2 Express which at the
point of release supports the following Windows OS versions:

Windows XP SP3

Windows Vista SP2

Windows 7

Windows 8
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Windows RT

Windows Server 2003 SP2

Windows Server 2003 R2 SP2

Windows Server 2008 SP2

Windows Server 2008 R2

Windows Server 2012

Recommended Screen Resolution Minimum: 1024 x 768

Recommended: 1280 x 1024 or higher

The specifications for the graphics card will depend on the user’s
requirements, some PC's are shipped with very low end graphics cards with
8Mb of memory. These should be avoided as it can result in a slowness of
performance when refreshing the screen especially when configuring/viewing
the status of the Tally system.

Other Ethernet/Wireless adapter fitted with support for IP connections.
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SQL Database Configuration

CommandCenter uses an ODBC connection to Microsoft SQL Server. The installation creates an instance of SQL called GVSQL that works alongside other
applications using MS SQL:

The database contains tables that hold different types of data, including user/groups, alarm log, status severities and program configuration. Redundant servers
will automatically mirror the SQL database.

The database can be backed up or archived in the same way as any other standard SQL database using Microsoft technologies. The configuration can be
backed up by CommandCenter.

The largest amount of data is used by the event log:

Size of online Alarm Log and the Audit Log can be controlled from configuration.

Automatic archiving of Alarm log can be enabled.

Note: It is highly recommended that you take a SQL class from Microsoft.
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Testing the SQL Database Connection

As part of the CommandCenter installation process, you will want to test the SQL database connection. For information on database error messages, refer to the
SQL troubleshooting topic.

Select CommandCenter Configuration>Configuration>SQL tab.After selecting the SQL configuration options, click Test.

Note that it may take several minutes to test the connection, after which the SLQ Connection Test screen appears:
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The SQL test verifies the state of the servers(s). The display always shows a secondary server even if one does not exist.
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SQL Error Messages and Troubleshooting Information

If the SQL database has not been installed properly then this can be the cause of this message:

CommandCenter fails to start with the following message 'Failed to initialize the SQL Database'

1. If CommandCenter has been running on this PC and then the SQL Server Express instance was removed the Microsoft uninstaller will leave the following
CommandCenter database files behind, for good reasons.

CommandCenter.mdf

CommandCenter_log.LDF

These files are normally found in the following path, although this could be different depending on other instances of SQL on the local machine.

C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data

If this is the case installing CommandCenter again will complain as the SQL installation does not expect to see these files and so does not start the service
correctly. This in turn causes CommandCenter to complain when starting as it cannot connect to the SQL database.

Assuming this is the problem with the installation we recommend to do the following:

a.) Delete the two CommandCenter database files mentioned above, unless there is information you wish to retain in which case either rename the file extensions
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or move them to another directory for the moment.

b.) Install CommandCenter again using the setup.exe executable from the installation disk or downloaded file.

c.) Try running CommandCenter again.

2.) If CommandCenter has never been running on this PC then the SQL Server Express might not have been installed correctly.

a.) Make sure that the setup.exe file was used to install CommandCenter. Using the CommandCenter Deployment.msi will not install the SQL Server, also running
the SQL Server installer (sqlexpr32.exe) from the SqlExpressSP2 sub folder from the installation will not add install the CommandCenter instance required for
CommandCenter to run.

b.) You will also have to be logged onto Windows as a user with administrator privileges for the local PC for SQL to install correctly.

c.) Given the above (a and b) are true, there are a number of other reasons for the failure of the installation.

. The " SQL Native Client" driver is not installed - On XP: Go to Control Panel->Administrative Tools->Data Sources (ODBC)->Drivers - " SQL Native
Client" should be in the list.

There is no SQL instance called CommandCenterSQL installed. Go to Control Panel->Administrative Tools->Services and look for " SQL Server
(COMMANDCENTERSQL)" in the list and check that Status is "Started".

The Surface Area (e.g. remote connections) for the SQL Server has not been correctly configured. In the Start Menu, find and run Microsoft SQL Server
2005->Configuration Tools-> SQL Server Surface Area Configuration. Near bottom of page, click on "Surface Area Configuration for Services and
Connections". A new dialogue should appear and in the left hand view select COMMANDCENTERSQL-> Database Engine->Remote Connections. The
right-hand side should now show the connection options. The options selected should be set to "Local and Remote Connections" and "Using both TCP/IP
and named pipes." If this is not the case, change these options and retry CommandCenter and/or steps 1 and 2.
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File Sharing

Supports CommandCenter file sharing over the CCLink protocol.

No file distribution is required.

The user configuration files (CLF, CMF etc) and data files have to be manually copied between servers (today).

The user files will be kept in the SQL database which will automatically synchronized between servers is in development.
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Viewing a List of Enabled Features

To view a list of enabled features:

From the application, select Help>About Command Center.
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Menus

CommandCenter menus allow you to perform a variety of functions:

The File menu allows you to switch users, enable or disable device control and import or export system configurations.

The Network menu provides you with the ability to perform a variety of network functions including a network refresh; find add and delete a device, manage
control interfaces backup and restore your system, produce an alarm report, produce a list of networked devices and edit common parameters between
cards. The card menu allows you to copy and paste card information, perform backup and restore, configure cards, compare settings, upload firmware and
print card properties.

The Card menu allows you to copy and paste card information, perform backup and restore, configure cards, compare settings, upload firmware and print

card properties.

The Configuration menu allows administrators to configure various aspects of CommandCenter, create user groups and assign permissions, create
control exclusions, assign status severity levels; load, unload and view the status of global macro files and reload SNMP MIB files.
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The View menu allows you to display the system, manual or device view, see the event log, view the currently selected card, see the event log, create a

customized user interface in the navigation, control and device view. You can allow the Audit trail to be shown or hidden. backup and restore user tables,
see automatically generated logic gates processed by CommandCenter, view SNMP errors, configure CommandCenter hardware, lock all views, hide
docked window titles, refresh views, run in full screen mode and hide or view the status or menu bar.
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File Menu

Switch User

The Switch User menu item will log off the current user and log on again using a different user name. This operation will not close the application but will interrupt
the monitoring of the network. A shortcut key (Ctrl-U) to this function can be pressed to prevent the need for having the menu bar when using the application in full
screen mode.

Toggle Device Enable/Disable

The Toggle Device Enable/Disable menu item allows you to enable or disable device control.

Import

This menu item allows you to import system configurations.

Export

This menu item allows you to import system configurations.

Clear

This menu item clears configurations. You may select: all, cables, categories, joysticks, mnemonics, routers, tallies and UMDs.

Exit

This menu item will close the application and return the user to the desktop. All logging for the CommandCenter system will then stop so any status events
occurring after this will not be logged to the database.
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Network Menu

Force Network Refresh

This item goes through all the network address on the current sub-net and any additional sub-nets added in the IP configuration to find any devices that are on the
network and add these to the System View if they are not already present.

Add Network Device

This item allows the user to manually add a device to the system view so it can be controlled and or monitored. The dialog presented when this option is selected
allows the user to choose the network devices available for this version of the software.

Discover SNMP Devices

This protected feature of CommandCenter allows the automatic discovery of SNMP devices currently on the network.

Delete Device from Network

This will delete the currently selected frame from the System View. The frames that were present the last time CommandCenter was run will be displayed in the
System View so this item can be used to tidy this view.

Clear All Frames

This will delete all the frames from the System View. The frames that were present the last time CommandCenter was run will be displayed in the System View so
this item can be used to tidy this view.

Backup System

This facility saves the identity, control and alarm objects of the devices to an XML format file. This file can then be used to restore the system to a 'known' state.
This is often used in studio or mobile environments where the configuration of the system changes from one program/event to another. If an event is being
recorded in Standard Definition (SD) then an SD configuration can be created and saved to a backup file, if the next event is being recorded in High Definition
(HD) then another backup file can be created and stored to a backup. By recalling and restoring from these two files the installation can easily be changed
between the two.

Restore System

This facility restores the identity, control and alarm objects of the Synapse devices from an XML format file. This allows the system to be configured to a 'known'
state.
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System Inventory

This allows the identity objects for all of the devices in the system to be saved as an XML file. This file is commonly used to import into an asset management
system or to check for the software / hardware versions installed within the system for maintenance purposes.

Print Network List

This will print the network tree in a tabulated format and include the device name, user name, location and channel/service details for each device in the system.

Edit Common Parameters

This feature displays a dialog that allows the user to see all the devices in one grid and allows the editing of common parameters for the cards. For example it can
be used to easily change the Card User Labels for each card from one dialog. Users can add additional parameters to the grid to show the same parameter
across multiple cards.
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Card Menu

Copy Card to Clipboard

This item copies the currently selected devices identity, control and alarm objects to a temporary store. This can be used as a convenient store in order to copy
and paste the same information to cards of the same card type.

Paste Card from Clipboard

This item pastes the contents of the temporary store within CommandCenter to the currently selected device. If the Card Type matches then the writable objects
within the control and alarm objects of the card will be changed. Devices that have different software/firmware versions can be used, as objects will only be
overwritten if the object labels match.

Backup Card

This option allows the settings of the currently selected card to be saved externally to the program to an XML file. This similar to Backup System apart from the
fact that only the currently selected device is saved to a backup file.

Restore Card

This option allows the settings of the currently selected card to be restored from an externally saved XML file. This option is similar to Restore System apart from
the fact that only the currently selected device is restored.

Default Card

This will default all the control and alarm objects of the currently selected device to the factory default settings defined by the object itself.

Configure Card(s) From Template

This facility can be used to configure multiple cards of the same card type a single file allowing systems to easily be configured to the default for a system without
having to perform multiple copy and paste operations.

Compare Cards

This facility can be used to compare the settings and status for the same card types. It highlights the differences between the currently selected card and the other
cards found on the network, it also allows the settings to be changed from the dialog providing a convenient place to change the same setting across multiple
cards.

Upload Firmware

This facility invokes a Firmware Programming dialog that is used to upload firmware to devices, this can be used to upgrade or downgrade cards in the system
without having to send them back to the factory.

Print Card Properties

This will print the objects for a card in a readable tabulated format, it will include the user data if used, identity, control, status and alarm settings for the currently
selected card in the system view. If the user selects the expandable group item in the IP Address tab of the system view then this option will print a label for the
card. This label can be used to overlay on the inside of the frame door. It will print the slot, card type and user name if the cards in the frame.
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Configuration Menu

CommandCenter Configuration

This item opens up a multi-tabbed dialog that configures various aspects of CommandCenter operation. This configuration is split into ACP, Alarm, Audit, IP,
SQL Database and User Interface categories. See the configuration dialog for more information.

User and Group Management
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This item allows the administrator to create user groups and grant access levels to aspects of the CommandCenter product, users can then be allocated to the
groups and passwords assigned for each user. See the user and group management dialog for more information

Status Severities

For each card type and/or card instance, the user can assign a status priority level to each state of each status object. In this way the user can determine for their
system as to what constitutes an error, warning or information. This option will display the status severity dialog used to configure these status levels.

SNMP Options

The following items are only enabled when the CommandCenter-SP option has been enabled either by a hardware key or demonstration mode key.

SNMP Templates

When adding an SNMP device to the system view a template can be assigned for similar devices. This template allows common parameters such as the control
exclusions, system severities, associated MIB files and the form displayed in the Device view to be configured. These templates can be configured using this
option which will open the SNMP Template Edit dialog.

SNMP Status Severities

For each SNMP device type and/or SNMP device instance, the user can assign a status priority level to each state of each object (using it's OID). In this way the
user can determine for his system as to what constitutes an error, warning or information when receiving information from this device. This option will display the
SNMP status severity dialog used to configure these status levels.

Control Exclusions

For each card type and/or card instance, the administrator can change what groups have access to what control. In this way operational users can be restricted to
only controls necessary for their scope of operation. This option will display the control exclusion dialog used to configure these exclusions.

SNMP Control Exclusions

For each SNMP device type and/or SNMP device instance, the administrator can change what groups have access to which control. In this way operational users
can be restricted to only controls necessary for their scope of operation. This option will display the SNMP control exclusion dialog used to configure these
exclusions.

Macro Browser

For custom functionality which is required to 'run' continuously whist Cortex is active, macro files (.cmf's) can be created with the CommandCenter Form designer.
These macro files need to be loaded into CommandCenter in order for them to run, the Macro Browser dialog gives the user the options required to manage
these files. These macro files should all reside in the GlobalMacros sub-directory of CommandCenter. Note: Custom macro files can only be run with the
CommandCenter Panel Viewer (CommandCenter-PV) option enabled.

Reload MIBs

This function will reload all the SNMP MIB files from the UserMIBs subdirectory within CommandCenter. The SNMP functionality within CommandCenter will
temporarily be halted during this process.
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View Menu

View Menu

All Views are optional and dockable, so the user can place a view on a preferred place on the screen. When the application is closed the workspace settings are
saved and will be restored when restarted.

System View

This view contains displays the current frames and cards in the CommandCenter network. The icons in the device tree indicates the status priority level of all
levels within the tree which summarises both the current and historical status. This menu item gives the input focus to the view if it exits, or creates the view if not.

Navigation View

This view allows you to create a customised user interface in the navigation if desired. When this user option is not enabled then the view is empty and should be
hidden.

Device View

This view contains several tabbed dialogs (Control, Monitoring and Classic) that allow the user to control and view status information about the selected device.
This menu item gives the input focus to the view if it exits, or creates the view if not.

Manual View

This view shows the manual for the currently selected card, it can be docked outside the main window to allow the manual to be viewed at the same time as
controlling or monitoring the cards status. This menu item gives the input focus to the view if it exits, or creates the view if not. Note this option is only available if it
has been enabled in the General tab of the CommandCenter Configuration dialog and also relies on a Adobe pdf compatible reader to be installed on the PC.

Event Log
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This view contains a list of events (status, alarm and optionally control) that have occurred on the CommandCenter system. The data is stored in an SQL
database and can be filtered on different user criteria. This menu item gives the input focus to the view if it exits, or creates the view if not.

Audit Trail

This menu item allows the Audit Trail dialog to be shown or hidden. This dialog displays the audit messages used for program operation logging. The amount of
data recorded is configured from the Audit tab of the Configuration dialog.

Engineering

Backup User Tables

This menu item allows the user to backup the user configuration to an external file. This can be later restored or used to configure another CommandCenter
application. These configuration items include all data that CommandCenter cannot retrieve from the cards directly.

Restore User Tables

This menu item will tell the application to load the user configuration from an external file the next time the application is started, as this operation cannot be
performed when the application is running.

Logic Diagnostics

This feature is used for diagnostic purposes only and has no function within the operation CommandCenter software. This menu item will display a dialog of the
automatically generated logic gates processed by CommandCenter to work out the status of the system. The dialog is split into three windows, a list of all logic
elements are displayed in the middle window, On selecting one of these logic gates, a list of the inputs for this logic element is shown in the left hand window and
a list of the logic elements this gate is providing is shown in the right hand window.

SNMP Errors

This dialog shows any errors as a result of parsing the loaded SNMP MIBs files.

Configure CommandCenter Hardware

As the hardware units have no user interface, this dialog utility allows the parameters of the unit to be configured. The unit will default to an IP address of
192.168.0.100 with a subnet mask of 255.255.255.0. If required these settings can be reset to their default value by pressing the default button on the rear of the
unit whilst powering the unit on or resetting the unit. Note: The unit cannot be configured in this utility if it is currently connected in the main CommandCenter
application.

Signal Path Diagnostics

This option is only intended for Grass Valley use only.

Generic Device Debug

This option is only intended for Grass Valley use only.

Lock All Views

This menu item locks the views and stops the user from being able to change the window layout from their current settings.

Hide Docked Window Titles

This menu item will disable/enable the title bar at the top of all docked views.

Refresh All Views (F10)

CommandCenter will cache the CommandCenter Layout Files (clf) files that it uses for the Device, Control and Navigation views, using this option or pressing the
F10 key will clear the cache and reload the clf files for the currently selected device and/or view. This option is useful when using the CommandCenter form
designer so that the latest change made can be viewed from Cortex without closing the application.

Full Screen Mode (F11)

CommandCenter will by default run in a frame window. Using this option (or by pressing the F11 function key) will run the application in full screen mode and will
hide the title bar of the application, and the Windows task bar. If the menu bar and status bar are hidden and only one view is selected, then it is possible to make
this view the full size of the windows desktop, for example when using the application in a touch screen environment. Reload All Files Reloads all files and send
and changes to CommandCenter clients. Reset Views Resets all views to default layout.

Status Bar

This menu item allows the Status Bar to be shown or hidden. The status bar of CommandCenter shows the current system status, a progress bar for lengthy
operations such as Force Network Refresh and indications for cap and num lock. In some situations particularly more vertical space is required for displaying

Menu Bar

This menu item allows the Menu Bar to be shown or hidden, when hiding the menu bar right clicking on a part of the CommandCenter frame not occupied by a
dockable window will display the View menu so access can be gained to change the views and enable the menu bar again.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.
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Enabling CommandCenter Views and Configuring Windows

You may use the View menu for various CommandCenter views and you may use the Options pulldown to customize window configurations.

From the view menu, you may select System View, Navigation View, Manual View, Event Log and Tally and Router Config, You also have the option to Lock All
Views, Hide Docked Window tiles, Reload All Files and Send to Clients (this reloads all configuration files) and Reset Views. You can choose to view or hide the
Status Bar and the Menu bar.

Use the Options pulldown (invoke by selecting the down arrow on the right of the System View menu) to customize the CommandCenter windows. You may select
floating, dockable, tabbed document, hide or autohide as your window options.
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CommandCenter Main Application Views

The CommandCenter application has 4 distinct views: system view, control view, device view and event log.

The size of each view can be changed independently Views can be docked, floating or operate as tabbed documents. The docked views can be auto hidden as
needed.
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System View

This view contains displays the current frames and cards in the network. The icons in the device tree indicate the status priority level of all levels within the tree and
summarises both the current and historical status of the system. The status indications are hierarchical so the network status shows the highest status level of all
the frames within the system, and the frame show the highest status level of all the cards within it.

Clicking with the left hand button on a device changes the control view to select this view. Once selected the device can be controlled and the status events both
current and historical can be viewed.

Clicking on the right hand button over a device brings up the card menu as shown below.

Alarm Masking

This menu additionally gives the option of masking the alarms for a particular node in the system tree. This can either mask just the node or mask all the inputs to
this node. If for example a card is due to be removed for service reasons, then you can mask the logic of the card to good in order to stop the CommandCenter
interfaces/ causing/showing an error on this node and any node to which this card is contributing its severity state when it is removed. Alternatively if a channel is
off-air then you could select the channel in the system view and select mask logic on inputs to good to stop any card allocated to this channel causing an error on
the system. Like each of the views it can be closed, automatically hidden using the drawing pin icon in the title bar of the view, or moved and resized to suit the
current application or users preferences.

Network Status

The status of the network is show as a single item at the head of the system view tree.

Frames

Frames are displayed as expandable items. The status of all devices in the frame are shown at the frame level. The frame device when selected displays the
frame controller in the control view.

Cards

Cards are displayed as icons with a status ! icon on the device having either a warning or error status.

Right Click Menu

When selecting a device from the System view, you may right click or select the Network menu to perform a variety of operations for that device. Additionally, the
status alarms for the card, frame and system can be acknowledged from this menu. System View Ordering The order of the devices within the view can be
ordered on different criteria. These criteria now include the user data that can be added for a device, such as the channel, service or location.
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Control View

The Control view screen will differ in appearance depending on the type of card selected. The control tab will contain a number of objects that controls different
aspects of the card. When a control is changed a command is sent to the card to change this item and feedback is then sent back to Cortex and the control items
within the dialog will be updated to reflect its current state. This means all changes are 'live' and will possibly effect the signal going through the card. The
administrator can change the control objects that users have access to, this will result in the control being viewable but disabled. Some features of a card will have
only been introduced on later versions of firmware. When CommandCenter finds this control is not supported by the card selected then the control is disabled.
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Edit Box Control

The edit box control allows the user to type a value into the box, the value is not sent to the card until either focus is taken away from the edit box or the return key
is pressed. Additionally when focus is on this control keys of the keyboard can be used to immediately step the value up (F5 or up arrow) or down (F3 or down
arrow), select the minimum (F2), maximum (F6) and factory default values (F4) for the control. If the value is outside the minimum and maximum range for the
control the card will change this back to the nearest achievable value

Multi-Choice (Combo Box) Control

The multi-choice selector, displays the options for this control in the drop-down list accessed from the down arrow on the right of the control. The option strings are
read from the card itself. As the card is limited in the number of characters it can use for this, then sometimes reference to the manual for this card type is required
to understand the options given. Selecting a new option will send the change to the card immediately

Slider Bars

The slider bar control is a live control and is used to reflect the current value of the control with respect to its minimum and maximum. It is often used in
combination with the edit box control and when this is so changing either control will reflect on the other.

Radio Buttons

When a limited number of options are available for a control, radio buttons are sometimes used to reflect the current and other available state/s of the control.
Such as the Phase control of the card shown below, where only 2 states are available (0 and 180 degrees)

Toggle Buttons

Some controls are represented as bitmapped values. Normally for these Toggle buttons are used as in the case of the 4x4 shuffler shown below to better
represent this to the user. Pressing the button will toggle the represented 'bit' on and off, making the control easier than a drop down list of options.
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Device View

This view displays information about the currently selected device. At present only one device can be selected at any one time. The information at the top of the
view describes the frame/card identity details as described below.

Identity Group

This includes the card type and description which are fields read from the card as well as the user name which as the name implies can be changed by the user to
better describe the function of the card in its current application. This field can be edited by pressing the edit details button on the right of the view.

Location

The IP Address and Slot number are known for a particular card. The location information allows the user to describe the physical location in the installation. This
optional information will aid unfamiliar users of the system to locate the card, these fields can be edited by pressing the edit details button on the right of the view.
Note: This information is not stored on the card itself but in the local database. Deletion of this physical database or use of another instance of this application will
therefore not currently share this information.

Service

The Channel and Service information allows the user to describe the services that might be effected by the card. In some circumstances this information may not
be valid although if the card were a distribution amplifier for a particular incoming line then it could be used in this circumstance to define the source or
destinations being fed rather than the channel. Note: This information is not stored on the card itself but in the local database. Deletion of this physical database or
use of another instance of this application will therefore not currently share this information.
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Using the Monitoring Screen to View Device Messages

Use the Device View Monitoring screen to access detailed information about event messages.

To access the Monitoring screen:

1. From the System View, select the device from the list and double click it.

2. Click the Monitoring tab.

3. Select an event row and right click to display the menu.
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4. Select View Details. The Event ID view details menu displays.

5. Select View Details.

From the Event ID Details screen, you may view message information such as the IP Address, Location (Room and Bay), Service (Channel and Service), Event
date and time, Source Name, Description, Ack Status, Severity and Alarm Durations. You may add a note in the free-form text field if you have the proper
permissions.
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Event Log

This view contains a historical list of events (status, alarm and optionally control) that have occurred on the CommandCenter system whilst the application has
been running. The data is stored and retrieved from an SQL database and can be filtered on different user criteria. This log of events will continue to grow until the
maximum database size is reached. At this point data is either deleted or archived to an external file. Settings for the database can be managed in the SQL tab
of the configuration dialog.

The view consists of an expandable list of events at the top of the view, A 'latest line display' will appear when the grid has been paused to view past events. This
display will show the latest event to have occurred on the system.

Like each of the views it can be closed, automatically hidden using the drawing pin icon in the title bar of the view, or moved and resized to suit the current
application or users preferences.

Each line of the event log shows the following parameters:

No.

This is a unique identifier number assigned when the message is received

Time This is the date and time the message was received. The time is in the form of hours:minutes:seconds:frames. The frame rate (fps) used can be configured

in the Alarm tab of the configuration dialog.

IP Address

This is source of the message that has been received, normally the IP address of the frame controller containing the card.

Source Name

This string displays the xard type and user name of the card generating the message. It also adds the slot number of the device in the frame if relevant. Event
Description This string displays an ASCII string of the event received. For a status update it will contain the word Status followed by the status object label and
state.

Acknowledge

This displays the state of the event and can be either N/A (Not Applicable) for information messages, New (for new warning or error messages), Acknowledged
(for manually acknowledged messages), Pending (for messages where the user has seen the event and is not acknowledging it until the cause is known) or Auto-
Acknowledge (where no manual acknowledge is normally required) For each status object of a card type, the user can assign a status priority level to each of the
states. In this way the user can determine for his system as to what constitutes an error, warning or information. This can be configured by using the Card-
>Configure Status Severities menu item. Warnings or errors in the system can be defined as being automatically acknowledged or not. This means that if a card
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status object is defined to be Auto-acknowledged a good status message will clear down the warning or error condition for this object if it exists. If the object is not
Auto-acknowledged then it will not clear the error or warning state until it has been manually acknowledged by a user of the system. The right double clicking an
event in this view will change the selection of the control view to the device that generated that event, giving easy navigation to the cause of the error or warning.

When over an event the right hand mouse button will bring up a list of options for the grid and event. as shown above.

Navigation

The grid will continue to update when any other events are received. This updating can be stopped by pressing the pause/start icon in the middle right hand side
of the grid, you may wish to do this whilst reading or editing the list. When the pause has been pressed the navigation keys become active so that the home, end,
page up and page down icons will then work as will the search and advanced filtering buttons.

Filtering (Good, Info, Warning, Error, Un-Acked, Advanced)

The items in the grid can be filtered by using the buttons to the left of the grid, de-selecting the good, info and warning buttons will mean that only the error level
items are displayed. Using the Un-Acked button the grid will display only events that have not been acknowledged. Using the advanced button (only available
when the grid has been paused) a dialog will prompt the user to select more complicated filters on the data viewed by the grid.

Search

This button which becomes active when the grid is paused, allows the user to search for a particular event using its ID number, or search to the event nearest a
date / time specified.

Ack Grid

This button will acknowledge all the events in the view currently selected. If no filter exists then it will perform the same task as the Ack All button below. Ack All
This button will acknowledge all the events in the system. This process may take a long time depending on the number of warnings / errors that have yet to be
acknowledged, a progress bar will show the progress of this operation.

Event Details

Viewing details for the event will bring up the following dialog it includes the parameters above as well as details of the card ID and who acknowledged the error.
The free format notes field allows the user to add relevant information into the system to describe the cause and actions taken. If information has been entered in
the Notes field
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Operations

Operations You may use CommandCenter for the following operations: compare settings and status for cards, configure systems using a template or backup files
and perform system backup and restore.
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Compare Cards

This operation can be used to compare both settings and status for CommandCenter cards with the same card type. It highlights (in red text) the differences
between the selected card in the system view and the other cards found on the network.

The settings for each card can be changed from the in-place editing within the grid, providing a convenient place to change the same setting across multiple
cards. Settings that are read-only will be displayed with a grey background.

If there are several cards of the same card type on the system then it may take a while to initially display the dialog, especially when the function is invoked soon
after the application has started.

To access the Compare Cards dialog:

From the Card menu, select Compare Cards.
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Compare Card from Template

Configure Card(s) from Template This facility allows a system to be configured using template or backup files. Cards, when shipped, are sent out with factory
default settings, these settings will not be suitable for some installations. By saving default backup or template files for card types a system can be easily
configured to a user's in-house setting from this dialog. These templates or backup files are the same as the files created by the Card/System Backup operations.
The current system is shown in a grid on the left hand side of the dialog and the file selection is on the right hand side of the dialog. Files/Templates are allocated
to devices by selecting the file required, selecting the card in the card template selection (if not already done) and then allocating it to the device by checking the
check box next to the icon for the card. If a system backup file is chosen then the cards that were a part of this backup will be shown in the Card Template
Selection grid. Warning: Configuring a device will potentially disturb the signal being applied to the device so caution should be taken to make sure the operation
is safe if the devices are being used 'On-Air'. It will also configure any preset values that are in the backup file, so cards with presets that control on-air
appearance will be changed as a result of this operation. Once the cards requiring configuring have been selected, the configure button should be pressed to start
this operation. The identity, control and alarm objects for each selected card will be configured to match the file allocated to it. A progress indication is given to the
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user as this is potentially a lengthy operation. If the configuration for any device was not successful then a warning message will be displayed and an warning or
error icon will appear next to the device.

Filter Based On Card Type

This option will display just the cards in the current system with the same Card Type as that selected in the Card Template Selection. This makes it easier to
assign the template to all cards of the same Card Type when they are spread over multiple frames.

Auto-Assign

When a backup file has been selected, the auto-assign button will attempt to match the cards in the network with the first card of the same type in the backup file.
The settings of the cards will not be changed configured until the Configure button is pressed.

Clear-Assign

This function will clear any assignment of file name against all network devices. 
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Upload Firmware

As and when new features become available for card types the firmware on users cards can upgraded to take advantage of these. Firmware files are known as
SPF files from the extension they use, and can be downloaded from the Grass Valley web site.

The Firmware Programming dialog allows single or multiple the cards within a system to be upgraded easily.
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To program a card:

1.  Select the device in the tree view of the system.

2.  Select an SPF file to assign to the device.

3.  Select the check box against the selected device, the selected file name will then appear in the device view

4. Once all the cards for programming have been assigned an SPF file, the Program Devices buttons should be pressed to start the operation.

A log of the progress is displayed in the right hand bottom window as well as progress indicators for card and total operation. After programming has
commenced icons are used against the device to give its programming status, yellow is used for the device currently being programmed, green is used for
a successfully programmed device and red is used for a device that could not be programmed for some reason. The log can be used for further information
regarding any problems in the process.

Note: Programming devices will disturb the output signal from the device, so caution should be taken to make sure the operation is safe if the devices are
being used 'On-Air.'

Reboot Under some circumstances a re-boot of a card maybe required. This operation normally takes a few seconds depending on the card type, if the
rack controller cards (RRXnn) are rebooted this will effect the control of the frame and cards within it so care should be taken when using this option. Note:
This option will only work for the rack controller IP configuration mode is set to Manual rather than DHCP.

Boot Mode Enable

Under some circumstances the boot mode for a card maybe required to be enabled/disabled. This is true for example on Linux based cards where the
cards firmware can be programmed by directly connecting to the Ethernet adapter on the card itself using a Web Server based interface and requires the
boot mode to be enabled to allow this interface to work. Selecting a card and pressing this button will enable the boot mode for the card, it will then become
non-controllable so caution should be taken before enabling this mode. If the boot mode for the card is enabled then the button text will change to Boot Mode
Disable and pressing the button again will attempt to re-boot the application firmware on the card if present.

Auto-Assign Latest

This option will attempt to assign the latest software firmware file for all cards within the system if not already up to date. It will base this assignment on the
card type and the hardware version of the reported card.

Assign Selected

This option will attempt to assign the latest software firmware file to the currently selected card if not already up to date. It will base this assignment on the
card type and the hardware version of the reported card.

Deselect All

This operation will deselect all the files that have been assigned to the cards in the network.

Save/Restore Settings

When re-programming a card the settings of the card will initialise themselves back to the factory defaults. In order to preserve the current settings, this
option should be checked.

Note: This option currently does NOT work for Frame controllers (RRCXX and RRSXX) as the IP settings are reset so the frame is potentially not restored back
to its current IP address on re- booting.

Check File Compatibility

This option will check that the SPF integrity against the card type selected when selecting this file against a device. This stops an invalid file being assigned
to a card. This option should normally be enabled.

Prompt On Error

This option when checked gives the user the option to continue programming if the programming status of the rack controller returns 'busy' when starting to
program a card. If not checked the programming process will not program the cards in this frame as another PC maybe currently programming devices in
the same frame. It will also prompt the user on the first programming error to occur, in case a batch programming

Filter Network by Card Type Selected

This option button can be pressed to show all the cards with the same card type as the one that is currently selected, useful when upgrading all the cards of
a particular card type when located in multiple frames.

Filter File List on Selected Card Type

This option helps in the selection of the correct SPF file, when checked the file list will only display files with the same name as the card type currently
selected in the network list. If the platform being programmed is to be changed or the card is in its bootloader mode then this option should be un-checked.

Once the programming operations have been completed the close button can be used to get back to the main CommandCenter window.
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System Backup

This facility saves the identity, control, status and alarm objects of all the devices to an external file in XML format. This file can then be used in future to restore the
system to the current 'known' state. This is often used in studio or mobile environments where the configuration of the system changes from one program/event to
another. Most often it is used to bring the configuration back to a 'normal' state, or if the system is being changed between different configurations like Standard
Definition (SD) and High Definition (HD).

The system will save the settings for each occupied slot in each frame. The settings will be assigned against the IP address of the frame. So if the IP address of a
frame or the slot position of a card or card type changes then the restore will not match and the settings will not be restored.

Different firmware versions of card types will not effect the backup and restore feature as the object is referred by its label rather than position.

The tree on the left hand side of the dialog by default selects all devices in the current system view to be backed up (denoted by a tick next to the device). Frames
or cards can be deselected from being saved to the backup file.

The drive and directory selection on the right hand of the dialog can be used to save the file to the desired location and the file name should ideally be changed to
be recognisable on restoration of the system. The XML file extension has been used by default so the file can automatically open in other programs that recognise
the XML format.

When the desired device filter and filename have been selected pressing the Backup button will save the settings to the file and update the give a progress
indication to the user. If the system has been working for some time all of the information should be in the local database and so the process should be quick, if it
finds that some information is missing for devices then it will interrogate them for this which will cause the process to be throttled back by the communication with
the frame. If the backup was successful or was not successful for any device then a warning message will be displayed. An icon by each selected device will show
whether it has been backed up successfully.
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Include Presets

Note that on some cards presets are used to store multiple settings of the same parameter, for these presets to be saved to an backup or archive file it may be
necessary to change the preset that is currently active for that card. This will potentially cause the on-air system to be effected so presets should only be saved if it
is safe to do so. For this reason the default for this check-box is off. For later cards that use presets the active preset is not normally effected. If you are in doubt
what effect this will have on your system and you are currently on-air then leave this option unchecked. The backup file can be viewed in tools such as Microsoft
Excel and if required can be changed given that the format of the original data is not changed. In this way simple off-line editing of a system can be achieved,
although this feature is due to be released in the near future. By using a file comparison tool differences between different configurations can also be found.
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System Restore

This facility allows the user to either compare or restore the identity, control and alarm objects of all the devices from an external file in XML format. This operation
is normally used to restore the system to the current 'known' state.

The system will restore the settings for each occupied slot in each frame. The settings will be assigned against the IP address of the frame. So if the IP address of
a frame or the slot position of a card or card type changes then the restore will not match and the settings will not be restored.

Different firmware versions of card types will not effect the backup and restore feature as the object is referred by its label rather than position. When opened the
tree view on the left is blank until a valid backup file has been selected using the drive and directory and file selection controls in the bottom of the dialog. When
the selection has been made a tree of the devices in the backup file will attempt to match with the devices in the current system view. If there is a match of the
same card type between the current system and the backup file at the same IP address and slot then the tree shows the device as present and the slot can be
checked to indicate the user wishes to restore/compare the values from the backup file to the card. If the IP address does not exist or the card type no longer
matches for a card in the same slot then the card cannot be restored. When selecting a card the right hand side of the dialog will perform a comparison of the
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settings (and status if the Show Status Differences option is checked) between the card and the backup file. This will by default only show any differences
between the two, if the Show Identical Params option is checked then it will show all the objects for the card.

Compare

Pressing this button will cause a compare on all the selected devices in the network and show the status of the compare in the right hand column of the tree. If the
card has the same settings as the backup file then it will report as "Present (CARD TYPE) - config same" in white text. If there is a difference in the settings then it
will report as "Present (CARD TYPE) - config different" in orange text, and will change the colour of the text for the frame in the tree as well. This comparison can
be used to easily identify differences in configuration from the 'normal' configuration used for a fixed installation.

Restore

Pressing this button will cause a restore on all the selected devices in the network, the status of the restore operation for a card will be shown as a round coloured
icon for each card/frame.

Warning: Restoring a device will potentially disturb the signal being applied to the device so caution should be taken to make sure the operation is safe if the
devices are being used 'On- Air'. It will also restore any preset values that are in the backup file if the Include Presets option is checked, so cards with presets that
control on-air appearance will be changed as a result of this operation. When the desired device filter and filename have been selected pressing the Restore
button will overwrite the settings to the card from the file, a progress indication is given to the user as this is potentially a lengthy operation. If the restore was
successful or was not successful for any device then a warning message will be displayed.
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Dialogs
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CommandCenter dialogs allow you to set up control exclusions for cards or an individual card, define the options for the user interface and other general settings,
change the list of usernames and passwords, set up or change status severity levels and create users and groups.
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Control Exclusions

Each card has a number of items that can be controlled. CommandCenter provides a way to protect the control of these items depending on the authority of the
user, these exclusions can be programmed by the administrator and any user group that has been granted access to the engineering menu items. The control
exclusions are currently held locally in the CommandCenter database.

CommandCenter allows the control exclusions to be configured for a particular card type which sets the default conditions for the card (using the Default tab),
additionally control exclusions can be configured for a group of cards or individual cards using the Specific tab. When opening up this dialog a list of the different
Synapse card types that are in the current system view will be gathered and shown in the upper window.

When one or more card types are selected the control objects for these cards are displayed in the lower window along with the configured user groups that have
been defined for the system (except the administrator which can always control all aspects of the system).

To create a control exclusion, select Control Exclusions and then the type (Synapse, SNMP devices or Generic Device) from the Configuration menu.

Click Edit which enables one or more of the check boxes to be enabled and thus excluding users assigned to this user group from being able to control this
control object in this type of card.

After changing one or more control items for a card click Apply to change the database value(s). If the apply button is not pressed then no user changes will
be made.
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Access Control

You have the ability to limit control to devices and individual objects for users and groups using the Control Exclusions dialog. You have the ability to select SNMP
Control Exclusions or Generic Device Control Exclusions.

Each group can have limited access to the CommandCenter application based on the restrictions set for that group. Each group can also be restricted in access
to individual control level on a device, using the control exclusions dialog. The limitations can be specific for a group for a specific product

To access the Control Exclusions dialog:

From the Configuration menu, select Control Exclusions>Synapse Control Exclusions, SNMP Control Exclusions or Generic Device Control Exclusions. The
corresponding Control Exclusions dialog displays.

The top of the screen displays the devices that can be controlled and the lower portion of the screen displays the individual control parameters for each group.
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By selecting the Specific tab, you can restrict groups access on the individual control level on a device.

For more information on limiting controls for users and groups, refer to the Dialogs - Control Exclusions topic for more information.
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CommandCenter Configuration

The CommandCenter application can be configured using this dialog. The dialog consists of separate tabs that configure different aspects of the system.
General, Notifications, ACP, ACP2, Router, SNMP, Panel, Alarm, Audit, SQL, and CCLink.
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Configuring the General Dialog

This tab of the configuration dialog defines options for the user interface and some general settingss.

Select Configuration> CommandCenter Configuration. The Configuration dialog displays.
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Enable Sort Toolbar

At the top of the Classic View list, a sort toolbar is shown. This can be disabled to give more vertical space for the list if not required.

Enable Tipbar

At the bottom of the Classic view list, details of the currently selected item can be shown. Un-checking this option will hide this data if not required.

Show Manual

The Manual page in the Control view is optional and can be disabled. This is sometimes desirable when an older version of Adobe Reader is installed as this
causes some issues when selecting between cards.

Show Device Specific Tabs

This allows the Control and Monitoring tabs to be disabled, when doing so only the Classic View will be displayed for the cards. This can be used if there is a
problem with the creation/use of the these tabs for a specific device and control of this device is required via the classic view.

Show ACP User Label in Network Tree

The label displayed in the Network tree can either come from the ACP card or from the Cortex SQL database. As the ACP string objects only support 8 bit
characters, multi-byte dependent languages like Chinese or Arabic are not supported. Un-checking this option will show the User name defined in the SQL
database.

Show Tally Info Window

This selection allows the Tally Info window to display.

Date Format and Language Settings
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The date format shown in the Event grids can be displayed in one of three formats, either European (dd/mm/yyyy), American (mm/dd/yyyy), or ISO-8601 (yyyy-mm-
dd).

Language

The default is Auto-detect.

Logon

When this option is enabled CommandCenter will look up the currently logged on user within Windows and attempt to match the user name against the
CommandCenter user database. If there is a match then the user will be logged in automatically without having to login.

Shutdown

Enable the confirm shutdown request option to be prompted when you choose to shutdowm CommandCenter.
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Configuring the Notifications Dialog

This tab configures the various notifications CommandCenter can generate as a result as a result of an error or warning from the CommandCenter logic engine.

Select Configuration> CommandCenter Configuration and click the Notifications tab.

Use Alarm

Select from Historical, Live or Combined for each of the dialogs: Alerts, Sounds, SNMP Traps, Email, Base SMPT.
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Alerts

Show Event Pop-up for Errors/Warnings

When an event is received that has its status priority set to error or warning this option enables a pop-up dialog to be displayed by the system to warn the user of
the status.

Flash System view for Errors/Warnings

The System view will display errors and warnings using an exclamation mark on the equipment in this state this can be optionally flashed for greater attention or
for people with color vision impairment.

Sounds

Play Sound

This gives the option of the local user interface playing a .wav sound file either when CommandCenter goes into an error/warning state for the first time or every
time an error/warning event is received

File

This is the name of the sound file required.

SNMP Trap

Send SNMP Trap on change of CommandCenter Severity

Checking this option will enable CommandCenter to send SNMP Trap messages to a Network Management System (NMS) or similar. This option is available in
the standard CommandCenter system. When the CommandCenter status changes either from Good to Warning/Error or Warning/Error to Good an SNMP trap is
sent with the current CommandCenter severity state and the

Dest. IP Address

This is the IP address of the primary NMS or SNMP trap receiver.

Port

This is the port of the SNMP trap message, this is normally set to 162

Community String

Authentification of SNMP V1 clients is performed only by a "community string" which is in effect a type of password. This is commonly set to 'private' and 'public'
for read/write and read only access respectively.

Send SNMP Trap to Secondary SNMP Manager

This will enable the option to repeat the SNMP trap message to another IP address for a redundant or secondary NMS.

SNMP Version

This will define the format of the sent SNMP messages.

Test SNMP Trap

When pressed this will send a SNMP trap message to the configured IP addresses with a 'trapDescription' 'saying "Test of CommandCenter SNMP Trap
Notification"

A CommandCenterTrap mib file is available for CommandCenter.

Email

CommandCenter can send an email either on a change of severity state within CommandCenter and/or on a periodic basis via a Simple Mail Transfer Protocol
(SMTP) server. The two check boxes allow the enabling of these options. Note you will need to configure the Base SMTP parameters for this to work. When
sending emails for change of severity state CommandCenter will send an email with the current severity state and will detail up to the last 10 events from the event
log. For the periodic email, CommandCenter will send a summary detailing the number of events, unacknowledged alarms, errors and warnings for the previous
period along with a compressed file as an attachment containing the event log for this period.

Common Parameters

Subject

This is the subject line of the email that will be sent, this will have the severity of the CommandCenter state appended to this text in parenthesis.

To/cc/bcc

The email addresses of the recipients. multiple email addresses should be separated with a semicolon (;)

Text Preface

This text will preface the automatically generated test for the email.
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Periodic Status Notification

Reporting Period (hours)

This is the time period defined in hours between the periodic reports.

Base SMTP

For the email settings to work the following Simple Mail Transfer Protocol (SMTP) server settings will need to be configured.

SMTP Server

This can either be an IP address or more commonly a DNS name of the SMTP server

Port

This is normally set to 25 for SMTP

User ID and Password

This is the ID and password for the unauthenticated SMTP connection

Senders Name and From address

This is the name and email address that CommandCenter will use to send email communication.
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Configuring the ACP Dialog

The ACP tab configures the characteristics for the Control Protocol (ACP). Normally these will not need to change, however on some systems where the network
is spread over a number of sub-nets or over a Wide Area Network (WAN) then changes to the default timeout values may need to change.

Select Configuration> CommandCenter Configuration and click the ACP tab.
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Number of Retransmissions

ACP is a connectionless protocol using User Datagram Packets (UDP), each ACP command sent by CommandCenter will be sent this number of times
(defaulted to 3) before it is deemed to have failed by CommandCenter. The audit log can be configured to show details of commands being sent again due to this
retry.

Default Timeout Value (mS)

This is the time given by CommandCenter after it sends a normal ACP command to wait for a reply from the Synapse frame (defaulted to 250mS)

File Timeout Value (mS)

This is the time given by CommandCenter after it sends a file packet used for uploading firmware to Synapse cards to wait for a reply from the Synapse frame
(defaulted to 10000mS).

Force refresh ACP value on access

CommandCenter by default interrogates all the cards in the system at initialisation and from that point on holds the information locally so subsequent requests for
the data are no longer delayed by the time taken to communicate to the device. CommandCenter is updated by receiving the Broadcasts from the frame, or
where the forwarding address in the frame has been directed at CommandCenter. However in some circumstances the user may choose for the card values to be
refreshed when the card is selected, this is normally required for frames that are outside the current Network subnet of CommandCenter or when Broadcasts are
turned off and forwarding not used. By default this option is set to 'If out of subnet'.

Enable Polling

CommandCenter will poll the frame and cards of the system at regular intervals to make sure the devices still physically exist on the network. As ACP is a
connectionless protocol, a frame can be removed and go un-noticed until the point that control is required. The polling is used to monitor the absence and
presence of the devices in the system.

Poll Time
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This is the time interval between polling messages being sent from CommandCenter. The default for this setting is 3 seconds, which will mean that each Synapse
frame will be polled within this time.

Treat Frame and Card Departure As:

This option dictates the status severity in the event of CommandCenter finding that a card that previously was present is no longer part of the system. This is
similar the configuring status severities of the system.

Auto-Correct Departure Errors

This option when checked means that any pre-existing warning/s or error/s in the event view for card departure will be automatically acknowledged or cleared
when the card returns. It is intended for items that do not need any historical warnings or errors to be acknowledged by the user.

Treat Card Entering Boot-Mode As:

This option dictates the status severity in the event of CommandCenter finding that a card that previously was present has gone into Boot-Mode and so is no
longer part of the system.

Auto-Correct Boot-Mode Errors

This option is the same as Auto-Correct Departure Errors but for the Boot-Mode events.

Indicate Frame Errors on Cards

As the frame controller is the means by which the card communicates to the outside world, the card is not a standalone entity. Enabling this option will reflect the
card in an error state when no communication can be established with the frame.

Log Control Changes

The Event log can optionally display any control changes seen on the ACP network or not, these control events will be displayed in a light blue color, as well as the
event description starting with the text 'Control -' . Only changes in values are seen in the log so repeated broadcasts of the same control value will not be logged
to save on storage requirements.

ACP Multi-Cast Address

Assigning this address will prompt CommandCenter to subscribe to a multicast address. This option can be used in preference to using UDP broadcasts, as it
will allow ACP updates to be sent across different sub-nets. If multicasting of ACP is required then the forwarding address of the frames should be enabled and
configured to be the same address within the range 224.0.0.0 though 239.255.255.255. If the broadcast option is disabled on the frame it will also remove a lot of
network traffic burden from the Synapse frames. Caution should be used when using this option as some third party control systems rely on the broadcasting of
ACP to maintain the correct system status.

ACP Networking

Transport Layer - default is Auto-Detect or Select UDP or TCP.
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Configuring the Generic Dialog

The Generic option allows you to specify how CommandCenter handles generic device connections.

Select Configuration> CommandCenter Configuration and click the Generic tab.
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Treat Partial Connection As (If Redundant):

This option dictates the status severity in the event of CommandCenter finding that only a single connection is available to a device that has two IP addresses.

Auto-Correct Partial Connection

This option when checked means that any pre-existing warning/s or error/s in the event view for partial connection will be automatically acknowledged or cleared
when both connections return.

Treat No Connection As:

This option dictates the status severity in the event of CommandCenter finding that a connection could not be made to this device.

Auto-Correct No Connection

This option is the same as Auto-Correct Partial Connection but for the No Connection events.
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Configuring the Router Dialog

This tab of the configuration dialog is only shown when the Router Control option is enabled.

Select Configuration> CommandCenter Configuration and click the Router tab.
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Router

This tab of the configuration dialog is only shown when the Router Control option is enabled.

Treat Partial Connection As (If Redundant):

This option dictates the status severity in the event of CommandCenter finding that only a single connection is available to a device that has two IP addresses.

Auto-Correct Partial Connection

This option when checked means that any pre-existing warning/s or error/s in the event view for partial connection will be automatically acknowledged or cleared
when both connections return.

Treat No Connection As:

This option dictates the status severity in the event of CommandCenter finding that a connection could not be made to this device.

Auto-Correct No Connection

This option is the same as Auto-Correct Partial Connection but for the No Connection events.

Re-assert Routes

Select this option to re-assert routes.
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Configuring the SNMP Dialog
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This tab of the configuration dialog is only shown when the SNMP option is enabled.

Select Configuration> CommandCenter Configuration and click the SNMP tab.

SNMP Manager

Defaults

Community String

This sets the default community string that CommandCenter will use for initialising the Add Device and Discover SNMP Devices dialog. It defaults to public which
is commonly used for SNMP devices.

Port Number

This sets the default community string that CommandCenter will use for initialising the Add Device and Discover SNMP Devices dialog. It defaults to 161 which is
commonly used for SNMP.

SNMP Version

Select the SNMP version.

SNMP Version 3 Settings

Select this option to configure SNMP Version 3 settings:

Context - enter the context name.

User Name - enter the user name.

Authentication - select none or MD5.
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Auth. Password - enter your authentication password.

Privacy - select your privacy option.

Privacy Password - enter your privacy password.

Connection Status Changes

Treat No Connection As:

This option dictates the status severity in the event of CommandCenter finding that a connection could not be made to this device.

Auto-Correct No Connection

This option when checked means that any pre-existing warning/s or error/s in the event view for no connection will be automatically acknowledged or cleared when
the connection return.

Polling

Poll Time

This is the default poll time for all SNMP OID's when shown in the user interface. This poll time can be overriden in the individual control within a CLF.

Incoming Trap (requires CommandCenter restart for change to take effect)

Port Number

CommandCenter will register it's interest in this port number when starting the application, the normal port number for SNMP trap notification is 162. Note: when
changing this value CommandCenter will need to be restarted for this change to take effect. Please note this setting is independent from the port number
specified for SNMP trap notifications.

Enable SNMP Trap Reception

Select this option to enable SNMP trap reception.

Enable SNMP Trap Receiver Status

Select the status as active or inactive.

SNMP Agent (requires CommandCenter restart for change to take effect)

Read only Community String

This sets the default community string that Cortex will use for initialising the Add Device and Discover SNMP Devices dialog. It defaults to public which is
commonly used for SNMP devices.

Read write Community String

This sets the default community string that Cortex will use for initialising the Add Device and Discover SNMP Devices dialog. It defaults to public which is
commonly used for SNMP devices.

Port Number

This sets the default community string that Cortex will use for initialising the Add Device and Discover SNMP Devices dialog. It defaults to 161 which is commonly
used for SNMP.

Agent Status

SNMP Sub-Sstem Error Logging (requires CommandCenter restart for change to take effect)

Logging Level

Select the logging level: Emergency (default), Alert, Critical, Error, Warning, Notice, Info, Debug.
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Configuring the Panel Dialog

Select Configuration> CommandCenter Configuration and click the Panel tab.
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Treat No Connection As:

This option dictates the status severity in the event of CommandCenter finding that a connection could not be made to this device.

Auto-Correct No Connection

This option when checked means that any pre-existing warning/s or error/s in the event view for no connection will be automatically acknowledged or cleared when
the connection return.

Treat PSU Failures As:

This option dictates the status severity in the event of CommandCenter finding that a PSU is in error on this device.

Auto-Correct PSU Failures

This option when checked means that any pre-existing warning/s or error/s in the event view for a PSU will be automatically acknowledged or cleared when the
PSU is present.
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Configuring the Alarm Dialog

Select Configuration> CommandCenter Configuration and click the Alarm tab.
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Alarm Log Time

Video Standard

The time for the event view is displayed in the following format hh:mm:ss:ff where ff is the frame number. The video standard setting determines the number of
frames in a second. Select PAL for 25fps and NTSC for 30fps.

Alarm Log Maintainance

Clear Alarm Log on Application Startup

The check box option allows the historical alarm log data to be cleared every time the application is started, this means that only the current status of the system is
shown when the application is started.

Clear Alarm Log

This button clears all the historic data from the event log.

ACP Log Settings

Log Control Changes

The Event log can optionally display any control changes seen on the ACP network or not, these control events will be displayed in a light blue color, as well as the
event description starting with the text 'Control -' . Only changes in values are seen in the log, so repeated broadcasts of the same control value will not be logged
to save on storage requirements.

Router Control Log Settings

Log Crosspoint Changes
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This option will enable the logging of all crosspoint changes from routing devices connected to the Event log.

Log Lock/Protect/Release Changes

This option will enable the logging of all lock/protect/release changes from routing devices connected to the Event log.

Generic Device Log Settings

Log Object Value Changes

Select this option to log any UMD changes.

Log GPI Changes

Select this option to log any GPI changes.

Log GPO Changes

Select this option to log any GPO changes.

Log UMD Changes

Select this option to log any UMD changes.

SNMP Log Settings

Log Received SNMP Traps

Select this option to log any received SNMP traps.

Log Received SNMP Trap Variables

Select this option to log any received SNMP trap variables.
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Configuring the Audit Dialog

The tab of the configuration dialog controls the amount of information that is stored in the audit log of the application. This log allows detailed information about the
operation of the application.

Select Configuration> CommandCenter Configuration and click the Audit tab.
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Audit Log Settings

UDP Logging

These checkbox controls the level of data for the UDP protocol layer. Normally set to Error only.

ACP Logging

These checkbox controls the level of data for the ACP protocol layer. Normally set to Error and Warning only.

Application Logging

These checkbox controls the level of data stored for the Application layer. Normally set to Error and Startup only.

Third-Party Protocol Logging

These checkbox controls the level of data stored for the third party protocols. Note this option is not port or protocol specific so it will log for all currently enabled
third party protocols, the Raw option should be used for short periods of time if fault finding. This is Normally set to Error and Startup only.

Macro Logging

Select this option to log macro logging error messages.

Clear Audit Log

This button clears all the historic data from the audit log. The check box option allows the historical log data to be cleared every time the application is started.

Application Logging

These options allow you to specify application logging preferences.
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Save Detailed Application Information

Select this option to save detailed application information.

Macro Message Logging (resets on restart)

Select this option to log macro messages.

Macro Action Logging (resets on restart)

Select this option to log macro actions.
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Configuring the SQL Dialog

This tab of the configuration dialog is used to configure the size and archiving settings for the SQL database that is used by CommandCenter.

Select Configuration> CommandCenter Configuration and click the SQL tab.
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Maximum Database Size (MB)

This shows the total size that the SQL Express database will grow to given the settings of the Alarm, Audio and App sizes below. Note: The total size for this
version of CommandCenter is limited to 4GB. The greyed out edit box to the right shows the current size of the database. The default size of the database for a
new installation of CommandCenter is 1GB.

Maximum Alarm Log Size (MB) and Maximum Audit Log Size (MB) and App. and User Config Size (MB)

This shows the desired size of the different parts to the database. The greyed out edit boxes to the right shows the current size of each in the current database.

Enable Alarm Log Archiving

When the Alarm Log database reaches the Maximum given above the data can be archived to a file external to the application. This option will enable this feature.
If this is not required then the non-active warning and alarm events will be deleted from the database.

Limit Alarm Log Archive Size and Maximum Alarm Log Archive Size (MB)

If archiving of the Alarm Log is enabled then optionally the application can check to make sure the total storage size of the archive files does not exceed the
amount defined.

Enable Audit Trail Archiving

When the Audit trail database reaches the Maximum given above the data can be archived to a file external to the application. This option will enable this feature.
If this is not required then the events will be deleted from the database.

Limit Audit Trail Archive Size and Maximum Audit Trail Archive Size (MB)

If archiving of the Audit Trail is enabled then optionally the application can check to make sure the total storage size of the archive files does not exceed the
amount defined.
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Archive Directory

The directory where the optional archive files are stored is defined here and altered using the browse button. Please note the files that will be created in this
directory will be named according to the date of entries being archived. So it is likely when the first files are created they will be named with a date perhaps 3
months previous, as these are the oldest events are the ones that will be archived first.

Use Default Local Database

This option should normally be checked for a standard CommandCenter installation, however in the case that a remote or redundant SQL database being
required this option should be unchecked to reveal further user options for the locations and login credentials of the database.
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Configuring the CCLink Dialog

This tab of the configuration dialog is used to configure the protocol used for the CommandCenter server application to communicate with CommandCenter client
applications.

Select Configuration> CommandCenter Configuration and click the CCLink tab.

Enable Client Connections

If multiple instances of CommandCenter clients are being used for a single system then the client/server application mode of operation should ideally be used.
When this is required the full CommandCenter application is used as the server application and this option should be enabled allowing CommandCenter client
applications including the CommandCenter designer to communicate with the server.

Multicast Address
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A valid multicast address should be defined for the CorLink protocol, this address should not already be in use by the LAN being used. The address should be
within the valid range of multicast addressing (224.0.0.0 though 239.255.255.255).

Server Name

This allows clients to view/select the CommandCenter server application required using a 'user friendly' name in the event of multiple CommandCenter servers
being accessible.

UDP Ports and Network Interface (application must be restarted before changes take effect)

The CommandCenter server/client applications requires the use of 5 unique UDP port numbers for the ComanndCenterLink protocol. The Multicast port can be
changed, but the remaining ports will follow and use the next 4 port numbers

Multicast Port

This port is used for the multicasting of status updates. Defaults to 40001.

CommandCenter Client Unicast Port

This port is used by the client to unicast to the server application. Defaults to 40002.

CommandCenter Designer Unicast Port

This port is used by the designer to unicast to the server application. Defaults to 40003.

Multicast Adaptor Primary IP Address

Accept the default or select another IP address from the list.

Enable Redundant Servers

When deploying a multi-client/server CommandCenter system the server becomes a single point of failure for multiple workstations. To protect against this there
is a cost option for CommandCenter to enable redundant servers. If this cost option has been enabled on the CommandCenter hardware key, this checkbox can
be checked to allow configuration of the redundant system.

Redundant CommandCenter Configuration (application must be restarted before changes take effect)

If you have the redundant server option, specify the primary, secondary and witness domain names.
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Status Severities

Each Synapse card has a number of status items that can be monitored. These severities will dictate how CommandCenter reflects the status of the Synapse
card in the system. The user can change the severity of these to reflect the importance of them to the user using this dialog. These status severities are currently
held locally in the CommandCenter database.

You may configure Status severities for Synapse cards, SNMP devices or Generic devices. Select the desired menu item from the Configuration menu> Status
Severities

CommandCenter allows the status severities to be configured for a particular card type which sets the default conditions for the card (using the Default tab),
additionally status severities can be configured for a group of cards or individual cards using the Specific tab.

When opening up this dialog a list of the different Synapse card types that are in the current system view will be gathered and shown in the upper window. When
one or more card types are selected the status objects for these cards are displayed in the lower left hand window. When selecting one or more status names the
State Severity grid will show the possible states for the selected items and the currently assigned severity setting for each state. When one or more of the states
are selected they can then be assigned to one of the following severities.

To make changes to the values the Edit button has to be pressed, it will then change its name to Apply to commit these changes to the database.

Table 1. Status Severities

Good Used to indicate a normal or OK state. It will clear all errors and warnings for this status item when the
status item is set to Auto-Correct.

Green

Ignore Used to hide unnecessary data from the user. Has no action on the current status severity. Not shown
in the event view.

n/a

Information Used, as the name implies, for information only. On receiving an event set to this severity it no action
on the current status severity.

Grey

Warning Used to warn the user of a possible problem or issue that does not command immediate attention. Orange

Error Used to warn the user of a problem or issue that does command immediate attention. Red

If the status item is a value such as 'Temp_Left' then ranges can be applied to the status severities to determine when the system should indicate a warning or
error for these status values.

A range can be defined by putting the minimum and maximum values separated by '..', two or more ranges can be separated by using a comma.
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In the example shown below:

Temp_Left and Temp_Right have been configured to signal the system to error between -128 degrees C and -1 degree C, show a warning from 0 to 9 degrees,
be good from 10 to 60 degrees, show a warning from 61 to 65 degrees and show an error from 66 to 127 degrees C.

The PSU_Bottom and PSU_Top status items have been defined as good when set to OK and show an error when set to NA.

Auto-Correct

This option in the Status name grid when checked means that any pre-existing warning/s or error/s in the event view will be automatically acknowledged or
cleared when an event set to a 'Good' severity state is received for this status item. It is intended for items that do not need any historical warnings or errors to be
acknowledged by the user.

When configuring similar status items such as Audio-1, Audio-2, Audio-3... etc you might want to program the same state severity in all of them, to do this select
all the similar status items and then select and configure the states.

After changing one or more states for a card press the Apply button to change the database value. If the Apply button is not pressed then no user changes will be
made.

If specific devices are required to be configured differently from one another than configure the default setting using the default tab and then configure the settings
that differ from this default using the specific tab. When selecting devices in this tab the settings have an additional option for selecting the default condition or not.
For example if the majority of the system is fitted with redundant power supplies then the default condition for the Redund_Ref_Pwr should be set to error when
Not Available (NA), however if a specific device at IP address 192.168.0.23 has only a single PSU fittted then a specific condition should be made to not error on
this condition by setting Redund_Ref_Pwr for this device to ignore or information for the NA state.

After all changes have been made the status severities then the dialog can be closed with the Close button or icon in the top right corner of the dialog. Any
changes made to the current view have to be cancelled or committed before the dialog can close.
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User and Group Management

The CommandCenter application allows access rights to be granted via user groups. These groups can be configured by the administrator with this dialog to
have access to different functions within the CommandCenter application and also control of the system configured from the Control Exclusion dialog.

Users can be created and allocated to these groups, giving individual password controlled access to the application. This dialog allows new users and groups to
be created, edited and viewed.

The dialog consists of two tabs one for editing Users and the other for editing Groups.

User Dialog

This dialog allows users to be added, deleted or edited. A user has to be allocated to a group and given a password, the password for a user can be blank if
desired, but no protection is given in this case for someone logging in as this user. The user inherits the access rights for the group that it is allocated to. There is
no limit to the number of users within the system.

It is recommended that once the application is installed and working the Admin password is changed so that other users will not be able to easily gain access to
this level of control.



4/2/2014 CommandCenter Topic Library

http://127.0.0.1:4587/core/sub/topic/t_topichead_topic_library_options.html 53/111

Group Dialog

This dialog allows groups to be added, deleted or edited. The group determines the access rights of the user allocated to it both with this dialog and the Control
Exclustion dialog. This dialog controls the access to operations within the CommandCenter application such as the ability to program cards, restore, configure the
SCP08 panels, etc. while the Control Exclusion dialog controls the access to the cards.

By default the application creates 3 user groups named Admin, Engineering, and Operator. The Admin group cannot be deleted or edited.

The Engineering group has by default been given all the rights of an Administrator apart from configuring how the application is configured. The Operator group by
default has been given no rights other than the GUI control and monitoring of cards. The restrictions on each group can be changed by selecting a group, pressing
edit and then changing the access to the permissions. Once the changes have been made press the Apply button to save them to the database and exit the
dialog using the Close button.

There can only be a maximum of 64 groups defined in the system. Please note a group cannot be deleted when it has users allocated to it. You may add an
unlimited number of users to a group. Each group can have limited access to the CommandCenter application based on the restrictions set for that Group. Each
Group can also be restricted in access to individual control level on a device, using Control Exclusions.

Initial Control View CLF

Select this option to select a Control View CLF file for a group or user. Use the browse button to add the file.

Initial Navigation View CLF

Select this option to select a Control View CLF file for a group. Use the browse button to add the file.
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CommandCenter Designer

CommandCenter Designer can be used to create custom GUIs with the style of interface required; they can be viewed in the server or client. There is no limit to
the number or type of devices that can be controlled. All of the intelligence is in the CommandCenter layout form (.clf) file, so user can determine how flexible a
control can be, and what it looks like. All standard device interfaces are created from a Template (.ctf) file and the control templates provide definable
attributes/functionality. Duplication of design is reduced by allowing panels (.clf) files to be added as a control element on another panel. Users can create ‘vari
ables’ or data holders to store data either on the panel or to/from an XML file for static storage. Macro files (cmf) can be created for automated event reaction.

Panel templates should always be saved in the Forms\Hardware panels folder to ensure they work correctly.

The panel template (CPF) should be saved in the default location: Forms\ Hardware Panels. A panel will not necessarily work correctly if stored in a different
folder.

CPF files are built around fixed button hardware panels but can also be used as a soft panels on a PC. To create a more custom panel, a CLF file can be used to
provide unlimited flexibility and customization for PC or tablet GUI. CLFs are created in a similar way to how the CPF was created. The examples provided can
also be modified to create custom panels.

CLF (CC Layout Forms) allow other types of panels to be created that are fully customizable in terms of button shapes, sizes and functionality. Button sizes can be
chosen to be suitable for touch screen use. Customization allow a panel to be designed with integrated control for routing and production switchers, modular
products, SNMP monitoring and generic devices. Custom panels enable the integration of control, monitoring signal status, alarms and video in a single control
interface. Duplication of design is reduced by allowing: panels (CLF files) to be added as a control element on another panel and creation of panels control
templates with definable attributes/functionality.

CommandCenter Designer has 4 views:

System view – Allowing drag and drop design of commonly used functions as in standard hardware panels. It does require the Router being used to be
online to see the sources and destinations.

Update Editor – property editor for current object modification

Toolbox – view to select standard controls

XML View – Raw data editing
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Designer and Panel Viewer Introduction

CommandCenter Designer can be used to create and edit custom GUIs with the type and style of interface required – these GUIs can be viewed in the the server
or client. There is no limit to the number or type of devices that can be controlled. All of the intelligence is in the CommandCenter Layout Form (.clf) file, so users
can determine how flexible a control can be, and what it looks like. All standard device interfaces are created from a Template (.ctf) file. Control templates provide
definable attributes/functionality. Duplication of design is reduced by allowing panels (.clf) files to be added as a control element on another panel. Users can
create ‘variables’ or data holders to store data either on the panel or to/from an XML file for static storage. Macro files (cmf) can be created for automated event
reaction.

Panel Viewer uses the CommandCenter Designer application to create custom panels and program standard hardware panels.
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Designer Installation and Configuration

The CommandCenter Designer application is installed with the initial installation of CommandCenter. You need to configure it before using the application:

From the CommandCenter Configuration menu, select Configuration.

Click the CCLink tab. The CCLink dialog displays:

Select the checkbox to Enable Client Connections.

Enter a Multicast address. The address must start with 239 (i.e. 239.1.1.1)

Leave the other parameters at the default unless otherwise required.
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Running CommandCenter Designer

1. Open CommandCenter Designer and enter the Multicast IP from the CClink page into the Multicast Window (if it is not already present in the pulldown).

2. Standard logon method should already be selected.

3. Login using your user name and password. (The default user name is gvadmin and the password is adminGV!)

4. Click OK, then close and reopen Designer to connect to the server. A network connection is required for Designer to connect.
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Designer Views

CommandCenter Designer has 4 views:
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System View - allows a drag or drop operation of commonly used functions as in standard hardware panels. It does require the Router being used to be
on- line to see the sources and destinations. To access System View, select it from the View menu.

Update Editor – property editor for current object modification. This view allows source names and IDs to be added without having the Router connected --

but this is more time consuming. To access the Update Editor view, select it from the View menu

Toolbox – view to select standard controls. To access Toolbox View, select it from the View menu.

XML View – Allows for raw data editing. To access XML View, select the XML editor button from the Update Editor screen.
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Creating a New Form Using Form Designer

Custom soft panel interfaces are produced with the CommandCenter Designer application. This application also allows for the creation of a sub panel that can be
used as a component of another panel. Each panel or sub panel is referred to as a Command Center Layout or clf form. The Update Editor feature allows existing
or new functionality to be created. A toolbox of controls allows components to be added to a form. The individual parameters can then be individually modified.

1.  Select the Form you want to use by opening the .CLF file:
From the File menu, select Open.

From the Grass Valley>CommandCenter>Forms>User Folder, select the .CLF file you want to use. (For example, Router Control.)

2. From the View menu, select Toolbox. You use the Toolbox to add controls to a form by dragging and dropping the control directly on the form.

3.  From the View menu, select Update Editor. You use Update Editor to view or modify individual control parameters. For example, select a control on the
form (such as a button). Update Editor displays the current state of the blank button. (With a blank template there will be no variables defined and the button
will be set for the default clear button state. It will do nothing when pressed.) Usually, a button will have 2 items: a local

4.  When you are finished adding controls, save the form under a new name. Select File> Save As Be sure to save your form to the User folder
(CommandCenter>Forms>User).
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Adding a Control to a Form

Toolbox

In order to add a visual element (control) to a form, select the Toolbox from the View menu. This view shows the available controls. To add a control, select the
most suitable control and drag this onto the form.
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The toolbox contains all the control types that are supported with this version of the designer, in addition it shows all the templates controls that have been loaded
from CTF files in the local installation. The template controls are based on a basic control type but also include extra functionality (templates) to ease the design
process and reduce duplication of the same functionality across multiple instances of controls. The standard or default templates supplied with CommandCenter
allow basic functions for Control Protocol (ACP), SNMP or routing devices to be targeted.

You can create your own templates to reduce duplication of common functionality, simplifying the design and aiding maintenance of the design. For more
information on creating forms, refer to the Creating a New Form Using Form Designer topic.
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Variables

Variables are used within CommandCenter to store data. They are generally used for sharing data between controls or acting as a common holder for either
static or non-static information. The designer can create as many variables as required to achieve the functionality for the control, form, view or application. Each
variable can be given a name of the designers choice, names are case sensitive and can be the same across the different types, for example a local variable
named 'CAMERA' and a panel variable with the same name can co-exist on a form and will be treated separately. If the designer wishes to assign a local variable
from a panel variable of the same name then this has to be added to the form in an appropriate place.

For example, if a generic form was created for controlling a specific device, but the title of the form changes depending on the use of this form, a panel variable
could be created called TITLE and used to initialise the Label control shown at the top of the form in order to show what device it is controlling.

Another example is where 20 controls require the same (or common) IP address of the device they are controlling, here again a Panel variable could be created
called IP_ADDRESS to hold this common value and then each of the controls would access this common value. If another device at a different IP address was to
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be controlled using this form then only a single change to the value of this variable would be required.

CommandCenter uses a few 'standard' panel variable names to make it easier when using the control templates. These are named:

IP_ADDRESS for the IP address of the device you are controlling (either ACP, SNMP or Generic)

SLOT for the slot of the ACP device you are controlling/monitoring

It is therefore good design practice to avoid using these panel variable names for any other purpose.
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Panel Variables

This opens a dialog that allow variables or 'data holders' to be defined for the panel. Panel variables are primarily provided to exchange data between controls
created on the same panel. For example, if a panel is created for a device like a Synapse card, then variables can be creating for the IP address and slot number
to allow these parameters to be passed into the form when invoking or adding this panel to a hierarchical panel. This then allows a single panel to be used in
multiple instances but targeting different devices in the system by changing these location parameters of the IP address of the frame and slot number where the
device resides.

From the Edit menu, select Panel Variable. The Panel Variable Initial Values dialog displays

There are no naming convention restrictions for these variables but again it is worth defining a strategy so that understandable and easily remembered names are
used. Variables are case sensitive so using a convention of all uppercase characters will help when designing the panels. There are no limits to the numbers of
variables that can be used within a panel. The standard templates supplied with the designer for ACP controls by default use panel variables named
IP_ADDRESS and SLOT, the SNMP templates also by default use a panel variable named IP_ADDRESS.

Note that there are different types of panel variables that limit the scope of the data:

Local - limited to the ‘local’ control. As the name implies, they can only be used within the control/form in which they are created.

Panel - limited to CLF files (used for custom panels). They can be used in different controls on the same panel or CLF file in which they are created. There

is an optional initial configuration in variables section of CLF file, editable from the panel variable dialog. They are accessible for the duration the panel is
visible (excluding tabbed pages).

View - limited to the view. They can be used in different panels or CLF files in the same view in which they are created. There is an optional initial

configuration from the ControlVariables.cvf or NavigationVariables.cvf file in the Variables folder. They are accessible for the duration the application is
open.

Application – limited to the local client or server application. They can be used across multiple views/global macros/hardware panels for the client which

created them. There is an optional initial configuration from the ApplicationVariables.cvf file in the Variables folder. They are accessible for the duration the
application is open.

System - read-only CommandCenter predefined variables. The following are the current list of supported system variables (or values): Work Dir. (Working

directory, from which CommandCenter is run.), Local IP (Dotted IP address of the local CommandCenter Client.), Server IP (Dotted IP address of the
CommandCenter Server the client is connected to.), Multicast Address (Dotted IP address of the multicast the client/server is using.), Server Name (As the
name implies.), Routers Enabled (CommandCenter option.), SNMP Enabled (CommandCenter option.), PC Name (Window's Computer Name), PC
FQDN (PC Fully Qualified Domain Name.)

Global– across all CommandCenter applications
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Data Stores

CommandCenter includes a method for storage or retrieval of static data from a file on the local data storage on the PC running the CommandCenter server/client
application. This storage mechanism is called a ‘Data Store’ and is a way of storing data or retrieving data formatted as an XML file.

Data Stores are used when the data being stored needs to be static or where the data is anticipated to change over time. This data can then be changed without
needing to know how to use the CommandCenter Form designer.

Examples of where a Data Store might be used in CommandCenter could be as a method to store the Router crosspoint status on a project/show basis or the
categorisation of Router Source/Destination mnemonics.

Like Variables an Event Handler can be added for notification of a node change within a Data Store.

Currently Data Stores cannot be shared across multiple clients or between clients and servers in the CommandCenter system.
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Expressions

Expressions in CommandCenter can be used either as a test in a logic block or as a result for an assignment. They are similar to formulas in a spreadsheet. The
expression editor allows a number of operators to be used to produce the required results. The table below outlines the supported operators which the expression
parser currently supports.

Operator Alternative Operator Function/Description

+  addition (numerical values and string)

-  subtraction (numerical values only)

*  multiplication (numerical values only)

/  division (numerical values only)

%  modulus (numerical values only)

==  equals to (numerical values and string)

=< <= less than or equal to (numerical values and string)

=> >= greater than or equal to (numerical values and string)

<<  Shift numerical value left by ‘n’ bits (numerical value)

>>  Shift numerical value right by ‘n’ bits (numerical value)

~  Invert (numerical values only)

^  exclusive OR (numerical values only)

! != not equal (numerical values or strings)

&  binary AND (numerical values only)

|  binary OR (numerical values only)

&& AND logical AND

||  logical OR

NOT  logical NOT

In the expression parser it will equate the parts of the expression as a number unless you tell it that you want it to interpret it as a string. To do this you have to put
double quotes around it. For example, to test if a panel variable contains a string “Bob:”

“PANEL_VARIABLE” == “Bob”

If multiple operators exist in an expression, and the order of processing of these are important to the evaluation of the expression then parenthesis can be used to
control this order of evaluation. For example:

((INPUT * 9)/5) + 32

This will multiply the INPUT by 9 first, then divide the result by 5 and then finally add 32.

When using a variable, expression or functions to the expression the ‘Add’ button MUST be used as this will generate the correct syntax for these keywords. The



4/2/2014 CommandCenter Topic Library

http://127.0.0.1:4587/core/sub/topic/t_topichead_topic_library_options.html 60/111

expression editor contains a test mode that allows an expression to be tested with dry run data in the designer, prompting the user for any ‘unknown’ values used
in the expression.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Functions

CommandCenter has in-built functions for common operations that either cannot be achieved using expressions or would be laborious to create.

Function Name Arguments Function/Description

CONDITIONAL_ASSIGNMENT
match,value,default,comp1,value1,comp2,value2..

..comp8,value8

Acts like a 'switch case' in c programming language.
Compares the 'match' against 'comp1,2,3 - 8' in turn
and assigns the 'value' to 'value1,2,3 - 8' depending
if the compare is true. Value is assigned to default if
none of the compares evaluate to true.

CREATE_COLOUR Red, Green, Blue, RGB or BGR Takes a red, green and blue value and creates a
RGB or BGR (normal) value in the form expected by
CommandCenter for setting control colours.

CURRENT_DATE_TIME Format
Gets the current date and time and formats it as a
return string in the format required.

%Y - Year, %m - Month, %d - Day, %H - hours, %M -
minutes, %S - seconds

DECODE_STRING String Removes escape characters from a string, reverse
of ENCODE_STRING see below

ENCODE_STRING String Encodes a string

EXTRACT_VARIABLE_NAME Variable Takes a variable string and strip out the user
defined part of the name

FIND_FIRST string, find string, start position Finds the position of the find string in the string
supplied. The find string can be either a single
character or a string

FIND_LAST string, find string Finds the last position of the find string in the string
supplied. The find string can be either a single
character or a string

FORMAT_NUMBER Number, Base, Digits, Precision Formats an ASCII string when given a number,
based on the base, number of Digits and Precision

GENERATE_ROUTER_ID_CSV ID CSV, Offset Generate a CSV of router IDs, with optional offset.
e.g. x=1,y=2,z=3 and offset = 1, result =
“|ID|2,|ID|3,|ID|4

GENERATE_ROUTER_ID_STRING ID Generate a router ID string from ID e.g. x=1, result =
“|ID|1”

GENERATE_ROUTER_LPR_STRING LPR Convert internal value for protect/release to a human
readable string e.g. x=0, result = “Unlocked”

GET_COLOUR_VALUE Extract, Colour, RGB or BGR  

GET_DATASTORE_COUNT File Path, Data Path Returns the number of child items from a 'Path' in an
XML 'File'

GET_DATASTORE_VALUE File Path, Data Path, Attribute Returns the value from an Attribute Path n XML file
File, Path,Attribute

MAXIMUM Value1,Value2...Value200 Returns the maximum value out of all the values
supplied

MINIMUM Value1,Value2...Value200 Returns the minimum value out of all the values
supplied

OFFSET_NUMBER_CSV Num CSV, Offset Offsets the numbers in a CSV string by the offset
given, eg "1,2,3" , "10" returns "11,12,13"

POSITION_IN_CSV String list, String Finds the string in the comma seperated string list
and returns its position in the string list (0 indexed)

RESOLVE_IP_FROM_ROUTER_NAME Router name Returns the IP address from the Router name
supplied

RESOLVE_ROUTER_NAME FROM_IP IP Address Returns the name of the router from the supplied IP
address

STRING_IN_CSV String list, Position, Separator Returns the string at 'Position' in the string list
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delimited with Seperator characters

STRING_TO_NUMBER String, base Interprets a string as a number at the required base.
'FE5412', 16 returns the decimal number equivalent

TRUNCATE/TRIM STRING Left trim, Truncate, Right trim, Input string Returns the modified string having removed 'Left
trim' characters (0 if no trim required), then truncates
the string to the number of characters specified by
'Truncate' (unless set <= 0), then removes a number
of characters on the right of the string determined by
'Right Trim' (0 if no trim required)

UTF8_ENCODE string Encodes the input string as a UTF8 string

UTF8_DECODE string Decodes the input UTF8 string
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Timers

Timers are used for automated or repeated tasks, such as flashing the background colour of a button. The minimum resolution for a timer is 100mS, so the
frequency of a Timer event is measured in multiples of 100mS. Timers also have scopes and can be defined as either Local, Panel or Frame. In this way if 20
controls need to flash at the same time/frequency then a single Frame timer should be used for all 20 controls.

Timers have an ID field so multiple timers can be used in the same scope.
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Adding Functionality to a Control

You use the Update Editor feature to add functionality to a control. (You add the control to the form by dragging and dropping the control from the Toolbox to the
form.)

1. From the View menu, select View Update Editor.

2. Select the control on the form.

3. To add functionality to a base control type, select the control on the form and then right click in the top half of the update editor

To add functionality to a base control type, select the control on the form and then right click in the top half of the update editor for this control. This will then present
the available options for this control. This will normally be an Event that you wish the control to take Action on. For example on a button you will normally add a GUI
Event handler for a left button click. After adding an Event if you select this Event in the update editor and right click again then the designer will then show
available options, this would normally be either and Action or a Logic block to evaluate some conditional expression before performing an Action.
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Configuring a Router Panel

You may use CommandCenter Designer to create and configure a router panel. Note that the router must be connected, since the router sources are read directly
from the Router Control Engine (RCE). You may open an existing panel or create a new panel to configure your router.
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Adding a New Panel

Create a new panel and then configure your router.

1.  From the File men, select New>Hardware panel.

2.  Select the type of panel to be programmed. Note that the forms are stored here: Program Files (x86)\ Grass Valley\ CommandCenter\ Forms\ Hardware
Panels. You will then set the controls for the router.

3. Save your file with a new name. You will then configure your router to be controlled.
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Opening an Existing Panel

You may open an existing panel and then configure it to control a router.

1.  From the File men, select Open> and choose the .cpf file you want to edit. Note that the forms folder contains default files of a specific type. There is also an
Examples folder that contains preprogrammed .cpf files that you may modify for use, if desired.
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2.  In the Simple Search tool, enter the word or a fragment from the beginning of a word.

3.  Save your file with a new name. You will then configure your router to be controlled.
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Panel Viewer Update Editor

Update Editor allows you to view and modify a button's paramers

From the View menu, select Update Editor.

 The Update Editor shows the current state of the blank
button. Typically a blank button will have 2 items: local variables and an initial configuration. These items can be modified and more functions added such as
templates, actions and events. With a blank template, there will be no variables defined and the button will be set for the default clear button state.
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Creating Router Panel Controls

You will create a variable for this panel. In this example, the variable will be to assign a value to the button. The Increment on Paste box is checked so the function
can be easily copied to other buttons to speed programming the panel.

1.  From Update Editor, select Local Variables and click on the ‘Ellipses’ button.

2.  Name the local Variable as shown as ‘ID’, ‘Specify’, ‘1’ and check ‘Increment on Paste’

3.  Increment on paste allows the value to update on each subsequent paste operation.
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Adding Functionality to a Router Panel Button

You add functionality to the button by adding a template. In this example we will add a Source Preset Button.

1. Select Add Item from Update Editor.

2. Select Add Template>Router Panel Controls ID>HW Source Preset Button ID. This defines the button as a Source Preset selection button based on ID
number. Using an ID number selects a source based on it’s ID number on the Router as opposed to the name. Using ID numbers allows the name to be
changed later without having to reprogram the panel. 
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Configuring Router Control from a Panel

Be sure the router you want to control is connected. After opening an existing panel or creating a new panel, you will configure it to control your router.

1.  From your panel, right click on the panel or from the Edit menu, select Router Panel. The Router & Category Panel dialog displays. From the Router &
Category Panel dialog, you will name the router and set the level and destinations.
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2.  Name the router being controlled. The name of the router must be the exact name of the router being controlled if you want to control Routemaster.

3.  Set the default destination. Note that the default destinations and levels determine the initial panel configuration. The destination is normally identified with
the ID number of the item being controlled. (The format is typically |ID|1, |ID|2, etc.)

4. Set the default levels. These levels determine which levels and be initially controlled. (The format is typically |ID|1, |ID|2, etc.)

Subsequent control of Sources Destinations and Levels depends on what functionality is given to the panel. The next step is to program the hardware panel
source buttons.
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Programming Hardware Panel Source Buttons

You must be connected to the router in order to do this as the router sources are read directly from the router control engine (RCE). The method for programming
source control buttons shown here allows for a quick configuration.

1.  From the View menu, select System view.

2.  From the list of networked devices, select the router you want to control.

3. From the Source tab, select the router panel take button.

4.  From the Source tab list, select the source or group of sources to be added, by dragging and dropping the selected source or group of sources directly
onto the panel.
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Creating Panel Variables

You will create a variable to assign a value to the button.

1.  From Update Editor, select Locale Variable and click on the Ellipses button.

2.  Name the local Variable as shown as ‘ID’, ‘Specify’, ‘1’ and select Increment on Paste. Increment on paste allows the value to update on each subsequent
paste operation

3.  To start the search, press Enter.
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Programming Hardware Panel Destination Buttons

You program the hardware panel destination buttons for the router by selecting the destination or group of destinations and dragging and dropping your
selection(s) directly onto the hardware panel buttons.

1.  From the System View, IP Address tab, select Choose Use IDs if the router ID is needed instead of the name. If left unchecked, the existing names will be
used. If a name is changed later, the button will no longer work.

2.  From the Dest(intation) tab, select the router panel selection button.

3.  From the Dest(intation) tab list, select the destination or group of destinations to be added. Drag the selection(s) to the panel buttons.
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Programming Hardware Panel Level Buttons
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You program the hardware panel level buttons for the router by selecting the level or group of levels and dragging and dropping your selection(s) directly onto the
hardware panel buttons.

1.  From the System View, select the Dest Level tab. Select Choose Use IDs if the router ID is needed instead of the name. If left unchecked, the existing
names will be used. If a name is changed later, the button will no longer work.

2. From the Dest(intation) tab, select Router Panel Selection button.

3.  From the Dest Level tab list, select the level or group of levels to be added. Drag the selection(s) to the panel buttons.
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Testing the Router Panel

The test mode allows a template to be tested and the button functions to be tested.

1.  Press Ctrl T. Next, you will verify that the destination, source and level buttons operate as expected.

2.  Enable the levels.

3.  Preset a source.

4. Select a destination.
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Testing the Router Panel Controls

This final step will make the associated panel (if it exists) active and if it is connected to the router put it in control of the router.The test mode also will control the
router if connected, without having any panel on line. This final step in testing involves adding a ‘Take’ button to allow the sources to switch.

1.  Choose the button on the panel.

2.  From Update Editor, right click and select Add Template>Router Panel Controls>HW Take Selection.

3.  Save the template.
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CommandCenter Options

The Control and Navigation Views in CommandCenter are used by the CommandCenter Panel Viewer Cost Option. This option allows you to completely
customize your user interface.

Pictorial representations of the workflow, signal path or physical surrounding can be created and linked together to create an interface to which operational and
engineering teams can quickly relate.

Users can monitor, control and locate informatikon without needing to understand the operation of either the underlying software application or the physical
implementation of an installation.

CommandCenter can also integrate the control of routers using native protocols. You can quickly design forms that provide access to router sources, destinations,
locks and protects as well as those with either generic or tailored interfaces depending on the context of the current view or task. For example, when selecting a
specific destination or source, the user interface could change to display other devices that may be controlled as a result of this knowledge and guiding the
operator in the choices available.

The SNMP otpion allows you to connect, control and monitor thousands of devices supporting the SNMP interface -- such as servers,switchers, character
generators, waveform monitors, IT infrastructure -- all from within CommandCenter. You start by scanning for and then adding SNMP devices to the System View.
If a device's MIB file is available, CommandCenter can set up status severities for any parameter you require. This generice data can then be presented to the
user in an appropriate way using any of the different controls supported by CommandCenter.
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SNMP Option

The CommandCenter cost option allows any Simple Network Monitoring Protocol (SNMP) V1 and V2c compliant devices to be added to the CommandCenter
system either for monitoring and/or control purposes. When this cost option is enabled on a CommandCenter system, any number of SNMP devices from
different manufacturers can be added to the system. There is no limit on the type or number of devices that can be added. Once you have a MIB, a control GUI can
be designed, control exclusions and status severities defined.

The first step in setting up SNMP is to make sure that the licenses to talk to the devices. To enable SNMP, you must install a separate Sabretooth license. For
more information, refer to the Licensing topic under the CommandCenter Broadcast System Control section.
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Prerequisites for SNMP Devices

The CommandCenter-SP cost option allows any Simple Network Monitoring Protocol (SNMP) V1 compliant device to be added to the CommandCenter system
either for monitoring and/or control purposes. When this cost option is enabled on a CommandCenter system any number of SNMP devices from different
manufacturers can be added to the system.
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The SNMP devices should be compliant with the following:

SNMP 'agents' should be compliant with at least SNMP V1.

SNMP devices should describe the SNMP implementation with the appropriate mib file/s. These files should be capable of being ‘compiled’ using an
independent and widely used tool set such as MGSoft without any errors.

CommandCenter requires the SNMP device to respond to a GET request to the following two Object IDentifierS (OID's) in order for it to be added as a
device to the system. Once the device has been added CommandCenter will continue to 'poll' these OID's to detect the presence or absence of the device
in the system.

iso.org.dod.internet.mgmt.mib-2.system.sysDescr.0 (1.3.6.1.2.1.1.1.0)

.iso.org.dod.internet.mgmt.mib-2.system.sysName.0 (1.3.6.1.2.1.1.5.0)

Note: There is now an option (since V1.09) to specify a Poll OID for an SNMP device so if a device does not conform to the recommended SNMP
specification then an OID can be defined when adding an SNMP device.

Cortex can process/receive unsolicited SNMP V1 and V2c trap messages from SNMP devices, but when these are used it is preferable to be able to get
the status object/s being referred to in the trap directly from a GET request.

Where SNMP trap messages are sent by the device, it should be capable of sending these to at least 2 different IP addresses as Cortex can be used with a
redundant server.

Note: There is no requirement of Cortex for SNMP trap messages to be supported by the third party device.

Enumerated integer types cannot have a value of 0.
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Adding an SNMP Device

1.  To add an SNMP device to the system, select either the Add Network Device or the Discover SNMP devices from the Network menu.

2.  To add a device that you know the IP address of choose the Add Network Device option and then select the Add SNMP device option. The Add SNMP
Device dialog will display.

3. Device Name/IP Addresses Specify the IP address of the SNMP device in the Primary IP Address field. If you want to address the device by name rather
than IP address in the configurable user interface, then specify a suitable unique name in the Device name field (this field is optional).

4. Port Number SNMP devices communicate using UDP on a particular port number. The default port number CommandCenter uses for new devices can be

configured from the CommandCenter Configuration dialog. As this port number can vary for each device, the value can be specified in this dialog.

5. Community The protocol uses 'Community' fields to control access for read-only and read-write access to the device. The required Community should be

configured for the device and will define the access that CommandCenter will have for the device.

6. Template When adding a SNMP device, a CommandCenter SNMP Template can be associated with the device. The CommandCenter SNMP Templates
are a way of grouping and associating the different information required for a specific SNMP device. This information includes: the CLF file/s and images
used in the Device View when the device is selected in the System View, the Status severities for the device, the Control exclusions defined for a user
group, the mib file/s used for the device and an SNMP trap macro file that can be automatically created/deleted when adding/removing the device. In this
way, the data that CommandCenter requires for a specific make and model of a device can be defined once, and then associated with, as many devices of
this make and model that are defined in the system. The use of SNMP templates is encouraged in CommandCenter to reduce the amount of device
configuration that is required.

7. Add When all the information is correct either press the 'Add' button to add a single device or press the the 'Add and Add Another' button if another device

of the same type is required with another IP address.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Discovering SNMP Devices

This option can be used to auto-discover or search for SNMP devices responding on the specified sub-net to the given port and community string. It is useful
when you do not know the IP address of a particular SNMP device in a sub-net, however you must know the port and the community string that it will respond to.
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1.  To add an SNMP device to the system, select Discover SNMP devices from the Network menu.

2.  After setting the correct settings press the Search Network button to carry out the search on this sub-net. If a device responds to it, then it will appear in the
grid . You can add the device to the CommandCenter system by selecting the row and pressing the Add Selected Device button.

3. When adding a SNMP device, a CommandCenter SNMP template can be associated with the device. The CommandCenter SNMP Templates are a way
of grouping and associating the different information required for a specific SNMP device. This information includes: the CLF file(s) and images used in the
Device View when the device is selected in the System View, the Status severities for the device, the Control exclusions defined for a user group, the mib
file(s) used for the device and an SNMP trap macro file that can be automatically created/deleted when adding/removing the device. In this way, the data
that CommandCenter requires for a specific make and model of a device can be defined once and then associated with as many devices of this make and
model that are defined in the system. The use of SNMP templates is encouraged in CommandCenter to reduce the amount of configuration of devices.
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Monitoring an SNMP Device

1. From Control View, click SNMP Monitoring.

2. Connect to the device:

3. From the Network menu, select Add SNMP Device.

4. Select the alarm severity from the Filtering section.

5. All SNMP events are logged to the SQL database. Selecting Device view shows a filtered list of events for the device you are viewing. If you select, Classic
view for an SNMP device, the MIB tree and raw data from device displays. The current values can be changed if you have been assigned the proper
permissions. Use Form designer to allow the OID to be selected from an OID selector. If Form designer is a client on the network, then it can be selected
from the device as well.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Tally Management Option

The CommandCenter Tally Management option provides an interface to production switchers via native protocols for bi-directional exchange of data for both Tally
and Mnemonics. It also allows for a cable map database and allows for signal path definitions for all devices including Grass Valley infrastructure. The Tally
Management option provides conditional logic control of tallies (UMD tallies and/or GPIs.) It also provides an interface to GPI/O units and allows you to assign
functions to GPI inputs such as CCU touch-downs. It also allows for management of UMD devices and provides support for common UMD/ multi-viewer protocols.
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The basic tally system allows source tallies from cameras and other sources to be activated based on their contribution to the live transmission path. A source can
be ‘On Air’ direct through a router for emergency mode, through master control via the router or through a switcher and master control or any other path that can be
selected. The tally configuration is based on defining the various paths that exist (cabling) and the internal selections form the various devices (routers, switchers
and master control. There may also need to be additional paths that are activated under special conditions such as emergency bypass. Tally connections to
external devices is often through hard wired connections from a GPIO box but could also be via a network.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Tally Management Option - Protocol Currently Supported

Current Generic Device Option protocol support includes:

GV DD35 Net (Mnemonic, tally and control of switcher )

GV ACOS (Mnemonic, tally and control of crosspoints )

GV M-2100 tally

GV CGP-4848

GV Karrera, Kayenne tally

TSL UMD over serial and IP

Image Video UMD

Penta RCP-1806

JL Cooper eBox
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Configuring a Tally System

Select View>Tally and Router Configuration to display the Tally and Router configuration screen. There are three basic steps to set up a tally system:

1.  If not already installed, Add the Networking devices contributing to the tally.

2.  Configure the Tally Cabling between devices

3.  Lastly determine the Tally Level to be associated with the Tally map. CommandCenter will need to be restarted before new devices appear in the Tally
Map.
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Adding Tally Devices

1.  From the View menu>select Tally and Router Configuration and select the Cables tab.

2. For each device, identify the Inputs and Outputs that will contribute to the tally system.

3. For routers and switchers, note that the levels and sources being tallied can be chosen.

4.  Only the levels, outputs and sources selected will contribute to the tally map. Note: Only the levels, outputs and sources selected will contribute to the tally
map.

This example shows 3 Cameras, An Encore Router, A switcher (Virtual) and a Summit DVR shown as a VTR.
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Adding Cable Information

A simple search checks the name, tags, description, comments, and custom texts of the assets.

1.  From the Tally and Router Configuration screen, select the Cables tab and select the Cable tab next to the Devices tab. The cable map displays.

2.  Make connections on the Cable map by clicking on the checkboxes to indicate how the devices are connected. Clicking on a square will change the state.
Devices like cameras may be fed to multiple destinations. Multiple tally levels can be used in the system. Mouse over the box to show information relating to
source and destination. Note that in the example below, Ccameras 1-3 feed into the router as well as to the switcher.
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Configuring Source Tallies

Configure source tallies from the Global Tally Map screen. Each device can be configured for different t ally levels.

1.  From the View menu, select Tally and Router, the Tally and Router Configuration screen displays. Select the Tally tab and then Tally to access the Global
Tally Map screen.

2.  Clicking on a source will show the active tally levels. You may change the tally levels.

3.  The Tally Map can show:
Cables and Internal connections (displays as red)

Routing (displays as blue)

Selected Tally states

Result:

Assets with names, tags, descriptions, comments or custom texts matching the search criteria are displayed in the Asset List panel.
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Configuring GPIO

Use the GPIO feature to add connections to the system. A GPIO has 48 inputs and 48 outputs and each can be used indepedently.

1.  From Device view, select the GPI Inputs tab. Make any required changes.

2.  From Device view, select the GPI Outputs tab. Make any required changes..

3.  Select the Monitoring tab to view the Status of the device and an error log.
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Configuring GPIO Tallies

The individual inputs and outputs of the GPIO device contributing to the Tally system can be added to the Tally Map and configured in the same way used for
routers and switchers.

From the View menu, select Tally and Router Configuration. The Tally and Router Configuration screen displays. Select the Tally tab to display the Tally Map
screen.
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Generic Device Option

The CommandCenter Generic Device Option allows for the control and monitoring of 3rd Party Devices using native protocols. the inputs/outputs and signal path
processing within the device is specified from an XML (CGD) file, similar to an SNMP MIB file. The CGD file also contains the control and status elements of a
device. This device description enables the CommandCenter client/designer to show/add GUI controls to either control or show status of the unit, independent of
the protocol being used and without changing the client application.
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Generic Device Option - Current Protocol Support

Current Generic Device Option protocol support includes:

Grass Valley M-2100 control and tally protocol

Grass Valley DD35-Net,

ACOS, Karrera, Kayenne tally

GV CGP-4848

Evertz Symphony (multiviewer presets)

For-A Hanabi tally and editor protocol

ICMP for simple ping device

Image Video UMD

JLCooper eBox

‘Raw’ UDP/TCP/Serial for ‘simple’ devices (for example, satellite receivers

Sony 9 pin protocol

Sony MVS/DVS switcher tally/editor protocol

TSL UMD Protocol (serial and IP), V3.1, V4 and V5

Penta RCP-1806

BACnet for building management sensors, temperature, humidity, etc.
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Testing a Generic Device

1. Select View, Control and click the Monitoring tab. Device View gives you a filtered list of events for the device you are viewing.

2. Locate the device in the list and make sure that it is listed as Fully Connected and Active in the Event Description column
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CommandCenter Alarm Engine Logic

CommandCenter allows the severities of status objects to be configured to one of the following states: Good, Info, Warning and Error. CommandCenter will then
automatically indicate the collective status of:

Status object

Device

Frame

System
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Each error/warning can be set to be acknowledged before clearing or set for Automatic. The information can be exported to an external log file.

For information on Alarm Configuration, see the Notifications and Alarm topics in the Dialogs section.
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Router Configuration Tasks

Before you configure your router, you must add it to the system.
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Router Control Overview

CommandCenter allows a large number of routers and other devices to be added to a system. The application reads the mnemonics from an existing router (if
available). Mnemonics can be overridden within CommandCenter. Routing devices can be added using the IP address or the device name. Matching names can
be achieved from a virtual panel to source/destination on a name or on an ID basis. Logical to physical multi-level mapping is available for specific protocols.
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Existing Router Control

The existing router can be an Encore or Jupiter router, or a supported generic router. When connecting to an existing router, the current source and destination
names are retrieved from the Router Control Engine (RCE). These names can be overridden in CommandCenter. The current router configuration can be
modified in the existing RCE if needed. Note that any existing panels will continue to operate in parallel with CommandCenter. In addition, CommandCenter
allows you to add additional soft panels or other custom GUI interfaces for use on any connected clients.
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New Router Control

In a new router configuration, the RCE names will simply identify the inputs, outputs and levels on each matrix. These names will be overridden in the
CommandCenter for use on hardware panels, GUI or other interfaces. All control comes directly from the CommandCenter except for the automation interface
which will be direct to the RCE. The Jupiter or Encore configuration can be located on the same server as CommandCenter.
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Router Control Considerations

The router configuration tasks cover how to install a router into Command Center and how to configure and control it. The Encore and Jupiter configuration can be
more involved; especially if this is an existing system in which case the naming conventions should match those in the exiting Router Control Engine (RCE).

The existing RCE (Encore or Jupiter) must currently be used to control these functions:

Source Exclusions (Only supported by the RCE)

Tie Lines (Only supported by the RCE)

Salvos (Supported by the both but with differences)
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Monitor Control

Visual Status Display

Areas

Automation or other external control (only supported by the RCE)
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Router Configuration Procedure

The procedure covers how to install a router into CommandCenter and how to configure and control it. Note: The Encore and Jupiter configuration can be more
involved, especially in an existing system, in which case the naming conventions should match those in the exiting Router Control Engine.

1.  Configure the New ‘Router Control Engine’ (RCE - Encore or Jupiter). Be sure to set the RCE to enable control from the CommandCenter PC IP address.

2.  Add the router RCE to CommandCenter Network devices.

3.  Name the router.

4. Configure the sources, destinations and level mnemonics (names) as desired.

5. Configure the Routemaster levels, breakaways, and other routers, if present.

6. Configure the panel templates.

7. Add the panels to the network and associate with the templates.

8. Create additional custom soft panels as needed.
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Router Control Methods

Within the router there are 2 control methods:

1. Direct control of router inputs, outputs and levels.

2. Control through ‘Routemaster’ virtual router.

Method 1 provides direct control and allows control of individual inputs across all levels without the ability to program ‘breakaways’ or isolate level control. Note
that breakaways can still be performed if programmed into individual panels.

Method 2 uses the Routemaster virtual router to program breakaway sources on different levels as well as combine control of multiple routers simultaneously.

Panels can be set to control either an individual router or ‘Routemaster.’

Note that you can use both direct router control or control through the Routemaster but not on the same router soft panel at the same time, unless you are using a
custom panel.
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Viewing a List of Network Devices Using System View

The System view ‘IP Address’ tab provides a list of network devices that are installed in CommandCenter. Each device has a specific icon. The status of a device
is indicated by the addition of cross (indicating no connection) or a triangle (indicating a warning) to the device icon. You may order the view based on either the
IP address or a range of other choices. The other choices typically require pre-assignment to a location such as rooms or bays.

1.  Select System View from the View menu.

2.  Select the router from the list of networked devices.

3.  Select the System View from the list of tabs: IP Address, Card Type, User Name, Room, Bay, Channel or Service.

4. Select the arrow to change the Network Device windo views: floating, dockable, or tabbed.
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Adding a Device from System View

You may add a device using the Network menu from the System View in CommandCenter.

1.  From the System View, right click or select Network to display the Network menu.

2.  You may add devices to CommandCenter using the Network menu. To add a device, select Add Network Device. You may add virtual devices that may be
used for testing purposes.

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Adding a Router

1. From System View, select the Network menu.
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2. Select Add Network Device, Add Routing Device

3. Select the type of router being added. Grass Valley products use one of three choices: ES switch, Jupiter or Native protocol (Encore). You may also choose
another generic router. Ton install a simulated router, select Virtual Router.

4. Choose Ethernet or Serial Control.

5. Name the device – the device name or IP can be used to select the device to be controlled. The default name is ‘ROUTER’!

6. Enter the Primary and Secondary IP addresses (if used).

7. Under ‘Advanced Settings’ enter additional information to determine how the Router is going to be controlled.

8. For Advanced IP Settings enter the port number if a port other than the default is required.

9. The Maximum Router size and Number of Levels should be entered. This determines the number of Sources, Levels and Destinations that can be
controlled.

10. Retrieve Mnemonics and Locks are normally checked so that restarting CommandCenter will update any Router information in case it has changed.

11. Set up SNMP info (if known).
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Viewing Router Status

Once a Router is installed, you can use Control View to examine the router status

Select the Network Device, then Device view.

Control is also possible by selecting a Destination, a Source and Levels then pressing Take
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Adding a Router to the CommandCenter Network Device list will cause it to interrogate the router and acquire the names of the Sources and Destinations. The
Device View will show the current status for the router if it is connected. If no connection can be established, an error will be flagged and the configuration will be
blank. This view is useful for testing and diagnostic purposes. It also provides a Status display with control capability.

You may also control the router by selecting a destination, a source and levels then pressing Take.

If you are using the ‘Virtual Router,’ the Source names will be fixed and the router will act as if a physical router exists.
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Router Device View Control

Device view can also be used to activate locks and protects on individual sources and levels. A lock prevents anyone, including the owner of the lock from making
changes. A protect prevents anyone, except the protect owner, from making changes. These can be overridden from the Encore or Jupiter Router Control Engine
(RCE).

Device View Control also shows the Router Lock and Protect status.

To set a destination Lock, Protect or Release:

From the Device view, select the Destination, then right click and select Lock, Protect or Release.
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Router Control Currently Supported Protocol

CommandCenter currently supports the following routers:

Grass Valley ES Switch, Jupiter (ASCII) & Native Protocol

NVision /Miranda (all)

Harris/ Leitch Pass-through

Pesa P1N and P1

Pro- bel /Snell SW-P-02 and SW-P-08 ( Studer , Calrec support)

Quartz/ Evertz RCP-01

Utah RCP-1 and RCP-3

Blackmagic Videohub

Nevion /Network V128

Sony Cart/+/++

Stagetec Nexus (over serial and IP)

Virtual router (for testing purposes)
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Router Control Engine Configuration

The existing RCE (Encore or Jupiter) must currently be used to control these functions:

Source Exclusions (only supported by the RCE)

Tie Lines (only supported by the RCE)

Salvos (supported by both with some variation)

Monitor Control

Visual Status Display (supported by both with some variation)

Areas

Automation or other external control (only supported by the RCE)

Note: The Encore and Jupiter configuration can be more involved especially if this is an existing system in which case the naming conventions should match
those in the exiting RCE.
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Controlling a Router from a Panel Set
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When a connection to a Router has been established, it can be controlled from any panel set to control the named router.If the name of the router is the default
name ‘router,’ then it will automatically be controlled by the Demo Router panels.

Open the ‘Router Control’ Panel example in the Navigation bar.

Test to see if the Router Destinations and Sources can be controlled.

Select a Destination first then chose sources to verify control. The names used will be those from the Encore/Jupiter RCE until new Mnemonics are created.
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Setting Router Names

The Router ‘ Mne ’ Mnemonics allows the router source, destination and level names used within CommandCenter to be overridden.

1.  From the View menu, select Tally and Router Config. The Tally and Router Config dialog displays.

2. Select the Router Mnemonics tab.

3. From the list of Network Devices, select the Router to be configured.

4.  In the Mne column, enter the new Router names.

If no names are used the Device Mnemonics will display as the default name.



4/2/2014 CommandCenter Topic Library

http://127.0.0.1:4587/core/sub/topic/t_topichead_topic_library_options.html 83/111

© 2014 Grass Valley USA, LLC. All rights reserved. Grass Valley is a registered trademark of GVBB Holdings S.a.r.l.

Tally and Router Configuration - Mnemonics

The Tally and Router Config tab is where both the router and Routemaster configuration is performed. The names of the levels, sources and destinations are read
from the router (if it is connected).

To access the Tally and Router Config tab:

1. From the View menu, select Tally and Router Config. The Tally and Router Config dialog displays.

2. The Mnemonics can be overridden as needed. But, the Virtual Router will have default names that cannot be changed.
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Router Device Mnemonics

Different Mnemonics can be used for the following display areas:

The Device Mnemonic comes from the Router Control Engine and cannot be changed in CommandCenter. If no new Mnemonics are added in the ‘ Mne ’ column
the Device Mnemonic will be used. The other Mnemonics allow different names to be used in different places if desired.

Router (Mne )

UMD (Under Monitor Display)

Switcher

Camera

Engineering
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Defining Routemaster Control

Use the Routemaster to allow different source configurations to be created and for the control of routers and levels.

1.  From the View menu, select Tally and Router Config. The Tally and Router Config dialog displays.

2.  Click the Routemaster tab.

3. Select the Levels tab to configure the levels.
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4. Select the Default Device from the list.

5. Select the default level from the list.

6. Click Add to add rows to the Levels and continue to control devices and levels.

7. From the Tally and Router Config dialog, select the Routmaster tab.

8. Click Add to add a row to the sources list, or click Auto Add to automatically add sources. Note that the number of automatically added sources is specified
in the Auto Add text box.

9. Select the sources and assign levels as needed. Routemaster can be used to control the following:
Logical levels ( Routemaster levels can control any router level)

Logical sources/destination are associated with specific router sources and levels

Virtual sources/destinations

Categories (these are used for grouping sources by type, such as Camaras, DVRs, etc.)

Level shuffling (Use for Audio channel swapping)

Configuration management to/from files

Route/lock status save/recall option

Result:

Assets with names, tags, descriptions, comments or custom texts matching the search criteria are displayed in the Asset List panel.
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Router Configuration Backup

Use the Export feature to backup the router configuration. Choose the Import feature to import configuration information into the system. If you choose the Import
feature, you may select the component configuration you wish to import.

To import a configuration:

1. From the File menu, select Import. The Configuration Import screen displays.
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2. Select the router configuration you want to import: Routmaster, Mnemonics, Crosspoints, Locks and Categories.

3. Click OK. Your router configuration information will be imported.

To export a configuration:

1. From the File menu, select Export.

2. Browse to the location where you want to save the configuration file (.ccf format).
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Monitoring Router Devices

All routing events are logged to the SQL database. Device view will give you a filtered list of events for the router device you are viewing. The status items are
assigned a priority level based on the information configured for that router. Item status information is colored coded: green for good, orange for warning, red for
error and grey for information only.

1.  From CommandCenter, select the router from the list of Network Devices.

2.  Select Device View.
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Router Control Capabilities

In addition to using the Device View, you can control a router from CommandCenter in two other ways:

1. By using a hardware panel programmed to perform specific operations. (Note that the panels are programmed with the CommandCenter Designer
application.)

2. Using a Soft Panel - CommandCenter Layout Form (CLF).
The Router control Navigation page is an example of a CLF.
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CLFs are programmed with the CommandCenter Designer application

CLFs run within the CommandCenter application on either the server or on a client workstation

CLFs enable full customization of a soft panel to incorporate multiple elements in addition to Router Control
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Creating Levels

1. From the View menu, select Control View.

2. From the Control tab, locate the router ID in the Router Status section.

3. Enter the Level in the LVL-X column.
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Creating Inputs and Outputs

1. From the Control tab, locate the router ID in the Route Status section.

2. From the Source Selection section, select the source.

3. From the Route Status section, select the destination.

4. Click Take.
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Creating Mnemonics

If the router is connected, the names for Levels, and Sources are Destinations are read from the router. Mnemonics can be overridden as needed. The Virtual

Router will have default names.

The Device Mnemonic comes from the Router Control Engine.

To create mnemonics:

1. From the Network menu, select Router Mnemonics.

2. In the Mne column, enter the mneumonic. Different Mnemonics can be used for the following display areas:

Router (Mne)

UMD

Switcher

Camera
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Engineering
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Testing the Router Configuration

1. Select View Control and click the Monitoring tab. Device View gives you a filtered list of events for the device you are viewing.

2. Locate the router in the list and make sure that it is listed as Fully Connected and Active in the Event Description column.

3. To test the router configuration from the GUI panel: Click the Destination button and the Source button. If the router has been successfully installed, the
Source button will turn green.
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Adding a Jupiter Router
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The Jupiter Configuration must be performed first to establish the router parameters on new systems:

Matrix – Configure the size and number of controllable Levels Inputs

Inputs – Define and name the sources

Outputs – Define and name the destinations

Levels – Define and name the levels

External Automation Interface – This must be done within the Jupiter CM4400 Controller

Existing Panels – These can communicate to the router or CommandCenter
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Features Available Only In Jupiter

The Jupiter (or an existing Encore) system must be used for these features as they are not available within CommandCenter:

Exclusions

Areas and Pages (Encore)

Salvos

Tie Lines

Automation Interface
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Hardware Panel Configuration

Hardware panels in CommandCenter are configured from templates. These templates are form files ( cpf ) with fixed button and display locations that match the
hardware. Opening a Panel Template in the CommandCenter Designer application allows you to define the buttons and display functions. The T=templates are
then associated with specific hardware panels to provide their functionality.
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Hardware Panel Overview

Hardware panels are configured from templates. The templates are form files ( .cpf ) with fixed button and display locations that match the hardware. Opening a
Panel Template in CommandCenter Designer allows the buttons and displays functions to be defined. Templates are then associated with specific hardware
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panels to provide their functionality.
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CommandCenter Hardware

Jupiter Panels

LCD16, LCD48

LD4, LD16, L64 , L32

S100, S50, S25, SXY

Encore Panels

48B, BPS, CLNT

PMB, UCP, XY

General Purpose Interface Unit

CGP-4848 1RU 48 input/output GPI unit

Note:

The General Purpose Interface unit provides external Inputs and Outputs typically used for Tally.
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CommandCenter Panels

Each panel holds 2 basic pieces of information: its name and primary and secondary server IP numbers. There is no intelligence in the panels, just buttons, knobs,
leds and displays. The functionality of the each panel is defined with the associated template which resides in the CommandCenter server.

All panels have:

Ethernet connectivity

Optional redundant power supply

Complete flexibility in user interface and functionality created using the CommandCenter Designer

Hardware Panel configuration is stored as a CPF file ( CClink Panel File)

LCD Button Panels have:

LCD buttons and one rotary encoder
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Adding Hardware Panels

You add hardware panels in CommandCenter in the Network menu in System View.

1.  From the View menu, select System View.

2. From the Network menu, select Add Network Device>Add CommandCenter panel. The Add CommandCenter panel displays.

3.  Select the Panel Type

4. Enter the Device Name.

5. Enter the Primary IP Address.

6. (Optional) Add the panel file by browsing to the location and adding it to the system. You create CPF files in CommandCenter Designer using a template
and creating a form. You then add functionality to the panel. There are two ways to do this: you can do it through Update Editor, or you may use System View
to "drag and drop" functionality onto the buttons from the devices in the system.

7.  Browse and add the initial settings file.

8. Check Redundant PSUs if the panel has redundant power supplies that you want to enable.

9. Click Add.
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Adding a Router to the Panel

1. From System View, select the Network menu.

2. Select Add Network Device, Add Routing Device

3. Select the type of Router being controlled.

4. Choose Ethernet or Serial Control.

5. Name the device – The Device name or IP can be used to select the device to be controlled. Default name is ‘ROUTER’!

6. Enter the Primary and Secondary IP addresses (if used).

7. Set up SNMP info if known.

8. Enter the Maximum Router size and Number of Levels.
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Viewing Hardware Panels

You view the hardware panels by selecting Device View and then selecting the Panel View tab.

To view panel messages, click the Monitoring tab.
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Viewing Hardware Panel Log Messages

Use the Monitoring View to see log messages from this device.

1.  From the Network Devices Ssytem View, select the hardware panel.

2.  Select Device View and select the Monitoring tab to see the log messages from the selected panel
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Associating a Template with a Panel

CPF files are associated with a hardware panel in CommandCenter by selecting the panel and entering the CPF file to use. CPF files are created in
CommandCenter Designer and allow you to define functionality to a panel.

1. Select the panel and right click. Select ‘Edit Device’ and entering the CPF file to use.

2.  Save the file and test the hardware panel to make sure that it operates correctly.
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Adding a Generic Device

1. From the Network menu, select Add Network Device, Add Generic Device.

2. Select the Device Category.

3. Select the Device Type.

4. Select the Device Version.

5. Enter the Device Name.

6. Enter the Primary IP Address.

7. Enter an Additional Configuration.

8. Enter a Sub-Device Configuration.

9. Click Add.
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Communicating with a Generic Device

Communicate with the device. See if there is an existing device that has been defined and has interface screens created.
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Configuring the Tallys

Before you begin configuring the tallys in CommandCenter, make a list of all of your tally devices and create the associations. Identify all of the indicators and
conditions you need to define to enable tally.
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Configuring Tally Devices

1. From the View menu, select Tally.

2. Click the Tally Devices tab.
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3. From the Tally Devices tab, select the devices you want to be part of the configuration. This might be a switcher, a router and a GPIO box, for example. On
the Tally Levels page, you add the tally levels you care about. (for example, “On Air,” or “Standby,” etc.) On the Tally tab, you’ll see a matrix of outputs and
inputs.

4. On the output section, down the left-hand-side, find the output that represents your different tally levels. For example, on my Virtual Switcher, you might set
the “Output” output to “On Air.”

5. Click on the little up arrow, and you get a window where you define the tally level for that output:

6. At the bottom of the window, you can set which tally level is being displayed in the UI:

With that set, the inputs and outputs which are On Air, now turn red:

Depending on how you’ve done your cabling setup, you should be able to follow the red tally indicator all the way back to your original source. In the example
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below, you can see that the CAM-5 source on my router is on the air.
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Configuring GPIO Tally

On the Tally Devices tab, click the desired gear icon(s). The Tally Actions window opens:

Postrequisite: From here, you can define what GPO gets triggered for a particular tally level. In this example, when CAM-5 is on air, set the GPO 7 on the 4848
device to high.
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Using Jupiter Panels in CommandCenter

Each panel has one or more CPF (CommandCenter Panel File) defined for it, providing default functionality. The CPF file can be found in:

Each panel has one or more CPF (CommandCenter Panel File) defined for it, providing default functionality. The CPF file can be found in:

C:\Program Files (x86)\Grass Valley\CommandCenter\Forms\Hardware Panels\Examples

A separate subdirectory exists for each panel type.

In some cases, multiple CPFs are provided giving the panel slightly different functionality. In such cases, any of those CPFs can be used when adding a panel.

In other cases, a main CPF file exists, with sub-panels providing additional functionality. In these cases, the main CPF must be selected when adding a panel.
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1 Destination 8 Levels

In this mode, the 8 buttons are used to select 1 of 8 destinations. The level(s) are preselected. Although this mode is called “8 Destinations 1 Level,” in reality any
number of fixed levels can be preselected. To modify which Levels are preselected, the use CommandCenter Designer.

1.  Open the 8 Destinations 1 Level CPF file.

2.  Right-click the Form.

3.  Select “Router Panel.”

4. In the Levels box, enter the level or levels you wish to be used. This can be a single level, specified as a mnemonic, or as an ID in the form |ID|n. Alternatively,
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it can be a comma-separated list of the same.
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4 Destinations 4 Levels

In this mode the 8 buttons are divided, with the top four selecting levels and the bottom 4 selecting destinations. By default, the destinations and levels selected
are the first four configured. To change this, the CommandCenter Designer must be used to modify the local variable “ID” for each destination button. (By default,
the ID variables are 1,2,3,4). To do this:

1.  Select a destination button.

2.  From Update Editor, click “Local Variables.”

3.  Click the “…” button next to “Set” in the lower panel..
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1 Destination 8 Levels

In this mode, the 8 buttons are used to select 1 of 8 destinations. The level(s) are preselected. Although this mode is called “8 Destinations 1 Level,” in reality any
number of fixed levels can be preselected. To modify which Levels are preselected, the use CommandCenter Designer.

1.  Open the 8 Destinations 1 Level CPF file.

2.  Right-click the Form.

3.  Select “Router Panel.”

4. In the Levels box, enter the level or levels you wish to be used. This can be a single level, specified as a mnemonic, or as an ID in the form |ID|n. Alternatively,
it can be a comma-separated list of the same.
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Other Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration

1.  Use the CommandCenter Designer to connect to a physical router.

2.  Open the Router Panel dialog.

3.  Specify the Router Name:
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Operation

The operation of the S25 and S50 panels is relatively simple.
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1.  Use the cluster on the right to select the level(s) and/or destination(s) (depending on the operation mode).

2.  Press a source button to initiate a take..

3.  To start the search, press Enter.

Result:

Note – configuring a breakaway, or locking a destination cannot be done with the provided CPF files for this panel.
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Main Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration:

1.  Use CommandCenter Designer to connect to a physical router.

2.  Open the Router Panel dialog.

3.  Specify the Router Name. 
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Main Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration:

1.  Use CommandCenter Designer to connect to a physical router.

2.  Open the Router Panel dialog.

3.  Specify the Router Name. 
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Category Family Configuration

The SXY has a set of buttons used to select a category name when used as a Jupiter Panel. Categories in CommandCenter are configured differently. Instead,
these buttons are configured on a per-panel basis to select a source via mnemonic family name.

For example, if there are a set of sources defined “Cam-1” to “Cam-10”, these buttons could be used to directly select a source by pressing a button
corresponding to “Cam-”, then one or buttons corresponding to the number.

The mnemonic family names for the panel can be configured in the CommandCenter Designer: , and .

1.  Open the SXY.cpf file.

2.  Right-click the form.

3.  Select “Panel Variables”..

4. Modify the variables “FAMILY_1” to “FAMILY_16” to match the source mnemonic family names.
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Basic Operation

The currently selected destination is displayed in the “Destination” OLE display. To change the selected destination:

1.  Press the Select button just to the left of the knob.

2.  The panel will enter the “MENU” mode. The SXY has only one sub-menu selection currently (Destination).

3.  Press the Select button again to enter the Destination selection mode.

4. Use the knob to scroll through the destinations until the required one is found.

5. Press the Select button again to choose the destination.

Once selected, the new destination will appear in the Destination display. The Status display will also update to show the primary source (and its levels)
routed to that destination.

The current preset source is displayed in the Preset OLED display. To select another preset source:
Simply rotate the knob to scroll through the sources, or use the cluster of 16 buttons on the right to select a source by mnemonic.

6. Press the Take button to take the preset source to the destination. The old source becomes the preset source, so repeatedly pressing the Take button will
toggle between the two sources.
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Configuring a Breakaway

To configure a breakaway, follow the directions under the Basic Operation topic to select a destination and preset source.

Once the preset source is selected, use the level toggle buttons on the left to select which levels should be used for the take.

To view the selected levels by name, press the “Level” button. The levels will be shown by name in the OLED displays. The level toggle buttons can be used
to toggle the levels.

Once the levels and source preset are selected, press the Take button to select the breakaway.

Result:

The Status display will update to show the current Primary source, and the Primary level (usually the first level mnemonic) for that source. To view the status for
each level, use the level toggle buttons to toggle each level – the Status will update to display the source for that level.
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Lock/Protect/Release

The Lock/Protect/Release button can be used to toggle a destination as Locked or Unlocked. To lock a destination and level(s):

1.  Select the destination as normal.

2.  Toggle the levels using the level buttons as required.

3.  Press the Lock button. When a destination is locked for a selected level, the Status display will change color to red. Additionally, where available, the owner
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of the lock will be displayed in the Destination OLED display.
To check the lock status for a destination, simply select it.

To check the lock status for each level, use the level toggle buttons to toggle each level on or off.
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S100, L64 and L32 panels

A single, main CPF file exists for these panels:

S100 panel – S100.cpf

L64 panel – L64.cpf

L32 panel – L32.cpf
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Main Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration, to connect to a physical
router:

1.  From CommandCenter Designer, open the Router Panel dialog.

2.  Specify the Router Name 
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Basic Operation

The S100 panel has 100 button-per-source buttons arranged in four rows. The L64 panel has 64 button-per-source buttons arranged in four rows. The L32 panel
has 32 button-per-source buttons arranged in two rows.

All of them have a cluster of buttons on the right for switching modes, and performing other operations.

The panels have two main modes of operation – “Take” mode and “Preset” mode. By default, the panels are in “Take” mode, which means that pressing a source
button will immediately take that source to the selected destination. The previous source becomes the preset source, so it’s possible to toggle between the
previous and current source by pressing the take button.

To switch to the “Preset” mode:

To switch to the “Preset” mode, press the “Preset” button in the top-right corner. In this mode, pressing a source button will make it the preset source (visible
in the Preset OLED display, or in the Status display on the L32). The source is not routed to the destination until the Take button is pressed. Again, the
previous source becomes the preset source, so it’s possible to toggle between the previous and current source by pressing the take button.

To change the selected destination, you can use the shortcut “Dest” button on the S100. For the other panels, press the “Menu” button, scroll to
“Destination?” and press the “Take” button. You are now in the destination selection mode. Scroll up and down using the arrow buttons (��) to your desired
destination, and press “Take” to select it. The Status OLED display will update to show the primary source and its levels routed to this destination.
Additionally, if you are in “Take” mode, the selected source will update to show the currently selected source.
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Configuring a Breakaway

To configure a breakaway, follow the directions in the "Basic Operation" topic to select a destination.

1.  Ensure the panel is in “Preset” mode, and select a preset source using the source buttons.

2.  Once the preset source is selected, press the “Level” shortcut button (or navigate to Level mode using the Menu button and the scroll keys).

3.  Once in Level mode, scroll through the levels, selecting and deselecting those required using the “Take” button. Selected levels are shown with an asterisk,
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unselected levels are shown without:

4. Once the levels are selected, press the “Level” button, or “Menu” button to exit out of Level selection mode.

5. Press Take to take the selected levels for the selected preset source to the destination. The Status OLED display will update to show the primary routed
source, and its corresponding levels.

Result:

Additionally, in Take mode, the panel will indicate a breakaway with a flashing red source button for the non- primary sources.
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Using LD16 and LD4 panels

A single, main CPF file exists for these panels:

LD4 panel – LD4.cpf

LD16 panel – LD16.cpf
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Main Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration:

To connect to a physical router, use the CommandCenter Designer, and open the Router Panel dialog. Specify the Router Name:
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Displays

These panels have multiple displays, labelled Dx. In the case of the LD4 panel, there is an additional set of displays labelled “Destination” and “Status.”

The displays labelled Dx, by default, display the current state of the levels for the selected destination. Additionally, they allow the selection of sources and
destinations when in the Source Selection and Destination Select mode.

On the LD4 panel, the “Destination” and “Status” displays show the currently selected destination, the current source for that destination, and any selected preset
source.

On the LD16 panel, this information is displayed in the D15 and D16 displays.
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Category/Family Configuration

The LD4 and LD16 panels have a set of buttons used to select a category name when used as a Jupiter Panel. Categories in CommandCenter are configured
differently. Instead, these buttons are configured on a per-panel basis to select a source via mnemonic family name.

For example, if there are a set of sources defined “Cam-1” to “Cam-10”, these buttons could be used to directly select a source by pressing a button
corresponding to “Cam-”, then one or buttons corresponding to the number.

The mnemonic family names for the panel can be configured in the CommandCenter Designer:

1.  Open the LD4.cpf or LD16.cp file.

2. Right-click the form.

3.  Select “Panel Variables.”

4.  Modify the variables “FAMILY_1” to “FAMILY_16” to match the source mnemonic family names.
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Configuring a Breakaway

To configure a breakaway, follow the directions in the "Basic Operation" topic to select a destination.

1.  Press the buttons next to the required levels, to ensure that the levels are highlighted as required:

2.  Follow the directions in the "Basic Operation" topic to select and take a source. The source will be taken only for the previously highlighted levels. The
status display will update with the current primary source, and the primary level for that source.

3.  To view which source is used for each level, toggle the levels by pressing the corresponding level buttons. The Status display will update to show the
selected primary source for the highlighted set of level(s).
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Lock/Protect/Release

The Lock/Protect/Release button can be used to toggle a destination as Locked or Unlocked.

1.  To lock a destination and level(s), select the destination as normal.

2.  Toggle the levels using the level highlight buttons.

3.  Press the Lock button. When a destination is locked for a selected level, the Status display will change color to red. Additionally, where available, the owner
of the lock will be displayed in the Destination OLED display. The display clusters for the corresponding locked levels will also update with the lock

information:
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Unused Buttons

In the default CPF file, the L16 buttons “Override”, “Seq” and the buttons “A”, “B”, “C”, “D” are not used. The user is free to re-assign these as required.
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Main Configuration

By default, the panel is configured to attempt to connect to the CommandCenter RouteMaster logical router. To modify this configuration, to connect to a physical
router:
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1.  From CommandCenter Designer, connect to a physical router.

2.  Open the Router Panel dialog.

3.  Specify the Router Name. 
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Changing LCD16 and LCD48 Panel Modes

By default, the LCD16 and LCD48 panels start in XY Mode. To change the mode of the panel:

Press the knob on the right. This will place the panel into menu mode, from which you can select how the panel operates. There are four modes to select
from currently: XY Mode, Single Destination Mode, Multiple Destination Mode and Level Mode.
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Using XY Mode

This mode is selected by default when the panel initially starts. It can also be selected from the main menu by pressing the “XY Mode?” button.

In this mode, each button represents a different destination. The destination mnemonic is shown on the bottom line of the LCD button. The current source for that
destination is shown on the middle line.

The knob on the right can be used to scroll through additional pages of destinations.

To route a source to a particular destination:

1.  Press the button corresponding to that destination. The panel switches to a source selection mode.

2.  Find the button representing the source (you can use the knob to scroll through additional pages).

3.  Once found, press the desired source button. The source will immediately be taken to the selected destination. The button highlights for a few seconds to

show that a take has been made: 

If a particular destination is locked, the button will light red and the owner of the lock will be displayed on the top line of the button.

Note: It is not possible to select a preset source, or configure a breakaway in XY Mode.
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Using Multiple Destination Mode

In this mode, each button represents a different destination. The current source for each destination is also displayed on the LCD button.

Unlike other modes, multiple destinations can be selected.

To select a destination, press the corresponding button. To deselect a destination, press it again. The knob can be used to scroll through additional pages
of destinations.

To perform a multiple destination take:

1.  Select one or more destinations by pressing the corresponding buttons.

2.  Press the “Select Source?” button to enter source selection mode, and press the button corresponding to the desired source. (Use the knob to scroll
through additional pages if necessary).

3.  Once the source button is pressed, the source is selected for preset, and the panel returns to the destination selection mode. The selected destinations

now show the current source, and the newly selected preset source: 
To take the preset source for all of the selected destinations, press the “Take” button. The buttons update to show the newly selected sources:
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From Multiple Destination Mode, it’s also possible to lock and unlock multiple destinations. The lock buttons performs a toggle action, so locked
destinations become unlocked and vice versa.

To lock multiple destinations, select them by pressing the corresponding buttons so that they are highlighted cyan:

Press the “Lock” button. Observe that the buttons change color, and indicate the owner of the lock:

To unlock multiple destinations, select one or more locked destinations and press the “Lock” button.

To deselect all destinations, and clear any preset sources, press the “Clear” button.
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Using Level Mode

This mode is used for creating breakaways. In this mode, a single destination is selected. The panel displays the set of configured levels, and the current source
for each level for the selected destination.

To select a different destination for this mode:

1.  Press the knob.

2. Press “Select Destination?” and press the button corresponding to the desired destination.

3. Press the button corresponding to the desired destination. The panel returns to the Level Mode, and updates to display the selected destination. By default,
all of the levels are selected. To deselect one or more levels, press their corresponding buttons. The buttons will display orange to indicate that they are

deselected: 
To create a breakaway:

Deselect the levels that are not required.

Press the “Select Source?” button.

Select the required source. (Use the knob to scroll through additional pages of sources).

The selected level buttons will update to show the newly selected preset source:

Press the “Take” button. The selected levels will update to show the current source:

To lock a set of levels, ensure the required levels are selected.

Press the “Lock” button. The buttons will update to display the lock status for each level:
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CommandCenter Customization

You may customize CommandCenter to monitor the system for problems, perform basic troubleshooting and configure SQL redundancy.
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Logging
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Logs are kept for all devices and can be examined to look for problems. Logs are useful for troubleshooting problems and troubleshooting CLF file functionality.
Most of the SQL data consists of logging information. Messages are displayed for xpt actions for a router panel. Take Messages are not monitored.
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Viewing Audit Trail Logs

Audit Trail Logging provides access to more detailed information from a device.

You configure the Audit Trail Log from the Configuration dialog.

To access the Audit Trail Log, select Configuration>CommandCenter Configuration.

From the Configuration dialog, select the Audit tab. The Audit Trail Log configuration dialog displays:

For information on configuring the Audit Logging dialog, see "Configuring the Audit Dialog" in the CommandCenter Configuration section.

To view the Audit Log, select View>Audit Trail. The Audit Trail log dialog displays:
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Depending how you have configured the Audit Log, the log displays detailed information about devices, messages display for xpt actions for a Router and
variable changes within CLFs. You may also export information to a log file.

The Audit Log view consists of an expandable list of events at the top of the view, A 'latest line display' will appear when the grid has been paused to view past
events. This display will show the latest event to have occurred on the system. Like each of the views it can be closed, automatically hidden using the drawing pin
icon in the title bar of the view, or moved and resized to suit the current application or users preferences.

Each event displays the following parameters:

No.

This is a unique identifier number assigned when the message is received.

Time

This is the date and time the message was received. The time is in the form of hours:minutes:seconds:frames.

Source

This parameter displays the source of the message (for example, application or card type).

Description

This string displays a description of the event received and, if applicable, the path.

IP Address (or other)

Note that the information that displays in this column depends on the data you are viewing. If you are logging the communications to and from a device, then this
column will normally contain the IP address of the device.

Clearing the Audit Log

The Clear Audit Log button clears all the historic data from the audit log. If you have configured the Audit Log to Clear Audit Log on Application Setup (by
selecting the check box option in the Audit Log Configuration dialog), the historical log data to will be cleared every time the application is started. For more
information, see the "Configuring the Audit Dialog" topic in the CommandCenter Configuration section.

Export

Use the Export feature to export the log, a specific message or group of messages.

Select the Export button. The Export Audit Trail dialog displays:
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File

Click the ellipses button, browse to the location you want to save the file. Name the file.

Export Entire Log

Accept the default setting to export the entire log.

Export Log Selection

Select this option to specify a First ID and a Last ID to export an error message or a group of error messages to the log.
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Configuring Redundancy

You configure redundancy in CommandCenter in the SQL Configuration dialog.

1.  Select Configuration>CommandCenter Configuration.
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2.  Uncheck Use Local Default Database.

3.  Check Enable Redundant Connection.

4. Click Test to check the SQL Connection.
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The SQL test verifies the state of the Servers(s). The display always shows a Secondary Server even if one does not exist. The example shows a non-
redundant system operating normally.
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Accessing CClink Status Information

The CCLink feature is used to configure the CommandCenter server application to communicate with CommandCenter client applications.

Configuration of the CCLink protocol information is done in the CClink tab:

Select Configuration>CommandCenter Configuration. The CCLink Configuration dialog displays.
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Be sure that the CCLink protocols are configured correctly for your environment. For information see the "Configuring the CCLink Dialog" topic in the
Dialogs section.

Note: When deploying a multi-client/server CommandCenter system, the server becomes a single point of failure for multiple workstations. To protect against this,
there is a cost option for CommandCenter to enable redundant servers. If this cost option has been enabled on the CommandCenter hardware key, this checkbox
can be checked to allow configuration of the redundant system.

You may use the CommandCenter Link Protocol statistics and Event Log can provide useful information in case of problems. Use the CCLink Protocol statistics
and the Event Log to view device messages that can alert you to any potential problems.

To access the CCLink Protocol Statistics dialog, select the node in the System View and select Device View. The CommandCenter Link Protocol statistics
dialog displays:

The CCLink Protocol Statistics dialog details the client connections and statistics of the CommandCenter communication protocol (CCLink), this is only used
when enabled and running in the client/server modal.

To access the Event Log from the CCLink Protocol Statistics dialog, click the Event Log tab.
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Trademarks and Agreements
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Trademarks

Grass Valley, GV STRATUS, GV Director, K2, Aurora, Summit, ChannelFlex, Dyno, Solo, ClipStore, Infinity, Turbo, Profile, Profile XP, NetCentral, NewsBrowse,
NewsEdit, NewsQ, NewsShare, NewsQ Pro, and Media Manager are either registered trademarks or trademarks of Grass Valley USA, LLC. in the United States
and/or other countries. GRASS VALLEY  is a registered trademark. Grass Valley USA, LLC. products are covered by U.S. and foreign patents, issued and
pending. Additional information regarding Grass Valley USA, LLC. trademarks and other proprietary rights may be found at www.grassvalley.com. Other
trademarks and logos used in this document are either registered trademarks or trademarks of the manufacturers or vendors of the associated products, such as
Microsoft  Windows  operating system, Windows Media  player, Internet Explorer  internet browser, and SQL Server™. QuickTime and the QuickTime logo are
trademarks or registered trademarks of Apple Computer, Inc., used under license therefrom. AVCHD and the AVCHD logo are trademarks of Panasonic
Corporation and Sony Corporation. Avid DNxHD is a registered trademark of Avid Technology, Inc., a Delaware corporation.
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